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PLEASE
Read this entire manual before
using the Hospira GemStar Pump

This manual is designed for use by healthcare professionals, caregivers, and patients.
The Hospira Technical Support Operations hotline is available 24 hours a day (in the
USA) to provide consultation and technical assistance regarding the Hospira GemStar
Pump.

In the USA: Hospira Technical Support Operations
1-800-241-4002

Outside the USA: Contact your local Hospira
sales office

To order additional copies of this manual
(List 13981) call Hospira Customer Care:
1-877-9HOSPIRA
(1-877-946-7747)
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Chapter 1
Introduction

The GemStar® Pump is a small and lightweight, single-channel infusion device
designed for use in the home, in the hospital, or anywhere electronic infusion is
required. The GemStar Pump can be powered by AC mains adaptor, rechargeable
battery pack, docking station, or two disposable AA alkaline or lithium batteries.
When powered by batteries, the GemStar Pump is ideal for ambulatory patients.

The following conventions are used throughout this manual:

Convention ‘ Use ‘ Example

[ALL CAPS] Pump keys Press [YES/ENTER] to continue.

ALL CAPS Display messages The pump displays:
ENTER TO CONFIRM.

WARNING: A WARNING message contains special safety
information and must be observed at all times. Failure
to observe a warning message could be life
threatening.

CAUTION: A CAUTION contains information that could prevent
irreversible product damage or hardware failure. Failure to
observe a caution could result in serious patient or user injury.

Note: A NOTE contains information or examples to help explain instructions.

Tip: A TIP contains information that makes the pump easier to use.

Note: Examples are provided only to help explain a pump function and may not
be clinically relevant. Graphics are for illustrative purposes only and may not
reflect the actual product.

Hospira GemStar Manual 430-00897-002 (Rev. 10/04) 1
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1. Introduction

GemsStar Pump Layout

Shown approximate size

2 Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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—

Displays the pump’s status.

DISPLAY
2 » Silences an alarm.
3 « Stops infusion.
4 » Starts infusion.
e Lights continuously when the pump is powered by AC mains.
» Flashes when the pump is powered by external batteries (e.g., battery pack).
* Not lit when using disposable AA batteries.
Power
Indicator
6 » Powers the pump on or off. To power-off the pump, press and hold until the
QUOF) display clears.
* Returns to previous steps during programming.
BACKUF + Exits Help, Change, and Options menus.
mn Displays the following menu items from the STOP or RUN mode*:
New Container Change Program (or Titrate VTBI)
New Program Piggybacking
* Resets a numeric value to zero.
wronsl Displays the following Options Menu items from the STOP or RUN mode*:
1 Review Program 5 Set Clock
2 Histories 6 Print
3 Keypad Lock 7 Speed Protocol
4 Pump Settings 8 Next Dose
10 @ @ « Scrolls through display messages.
» Toggles between AM and PM in time-based entries.
* UP arrow enters a decimal point in numeric entries.
» DOWN arrow toggles between units of measure when entering concentrations.
1" * Responds “YES” to display questions.
» Accepts entries and goes to the next step.
12 * Responds “NO” to display questions.
13 » Displays information during programming steps and alarm conditions.
HELP] . Displays Shift Totals, except during programming steps and alarm conditions.
14 * Clearsan AIR-IN-LINE alarm.
*  Primes a Gemstar Pump Set.
15 [0]-[9] + Selects menu items and enters numeric values. If two numbers appear before a

menu item (e.g., 02), press both number keys to select that item.

* Not all menu items are available with all modes.

Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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GemStar Pump Components

11

Bolus Button

Pole Clamp Track

Cassette Release
Button

Power Connector

Data Port
Connector

Bolus Connector

Tubing Channel
Cassette Pocket
1.V. Tubing Guide

Battery Pack
Connector

Battery Compartment

Press this button to start a
bolus delivery if available in
the current program.

Use to connect to an
optional pole clamp.

Push down on this button to
release the cassette.

Use to connect the AC
mains adaptor.

Use to connect the GemStar
serial cable.

Use to connect a bolus cord.

Place the pump set tubing in
this channel.

Load the cassette into this
pocket.

Use to hold the I.V. tubing.

Use to connect the GemStar
Rechargeable Battery Pack.

Install two fresh, disposable
AA batteries in this
compartment.

Top View

Bottom/Side View

Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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1. Introduction

Therapies

Seven types of therapy are available for infusion of medications and fluids. The
following table lists possible applications and available features of each therapy.

Therapy Possible
Applications

TPN Total Parenteral
Nutrition fluid o .
delivery

Pain Infusion of
Management | analgesics or
anesthetics for
patient-

controlled pain
management (PCA)

Intermittent Interval-based
therapies such as .
antibiotics

Continuous Infusion of mg, mcg,
or mL/hr with a
selectable KVO . . .
(Keep Vein Open)
option

Weight Dosed | Critical care,
pediatrics

mL/hr Only Simple rate
programming

Variable Time | Chronotherapy . .

* = Available

'\4 Note: Not all therapies are available in all pump configurations.

Hospira GemStar Manual 430-00897-002 (Rev. 10/04) 5
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1. Introduction

GemStar Pump Features

Feature

Adjustable
Settings

‘ Description

Adjusts the distal occlusion pressure limits,
air sensor sensitivity, real-time clock, and
audible alarm volume.

‘ Reference Page

Chapter 10 Options
Menu

Alerts and
Alarms

Signals audible and visual alarms when
attention is required.

Chapter 12
Troubleshooting

Audible
Keypad
Response

Sounds a single beep when any key is
pressed. If an invalid key is pressed, the
pump sounds a flutter tone.

Chapter 1 Introduction,
GemStar Pump Layout

Keypad Lock

Restricts access to various options. Four
lock levels are available.

Chapter 10 Options
Menu and Chapter 11
Clinician Instructions

New
Container

Repeats the current program without
reprogramming the pump.

Chapter 2 Basic
Operation

Piggybacking

Allows delivery from a secondary container
during a Continuous or mL/hr Only
program.

Chapter 6 Continuous
and Chapter 8 mL/hr
Only

Power-on
Self-test

Performs a self-test each time the pump is
powered on.

Chapter 2 Basic
Operation

Operation
Test

Performs user-assisted tests to verify the
pump is operating properly.

Chapter 14 Operation
Test

Program
History

Maintains a history event log, with a date
and time stamp of each event for each
program. Review the history on the display,
or download it to a printer or computer.

Chapter 10 Options
Menu

Speed
Protocols

Stores up to nine frequently used programs
in the pump’s memory for quick access.

Chapter 10 Options
Menu

Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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1. Introduction

Menu System

The GemStar Pump uses a menu system that provides step-by-step instructions
through all of the pump’s functions. Refer to the following table for a list of functions

in each menu.

Use the keypad to select menu items, respond to display messages, and enter numeric
values. For example, press [2] to select PAIN MANAGEMENT from the Programming

Menu.

Note: Menu items may vary depending on the pump s configuration.

Tip: A menu item does not have to be on the display to be selected. For example,
when the Programming Menu first displays, only the first four therapies are shown.
Instead of pressing the down arrow to see the other menu items, press [7] to go

directly to Variable Time Programming.

Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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To display

this menu:

Do this:

Menu Items Available

Programming
Menu

1 Press w to display
the Change menu.
2 Select NEW PROGRAM.

TPN
PAIN MANAGEMENT
INTERMITTENT
CONTINUOUS
WEIGHT DOSED
mL/HR ONLY
VARIABLE TIME

N oUW R

Note: If a program is not currently stored in
pump memory at power-on, the Program-
ming Menu automatically displays after the
self-test.

Change Menu

Press |CHANGE|.

NEW CONTAINER
NEW PROGRAM
CHANGE PROGRAM
PIGGYBACKING

Note: Ifthe current therapy is Weight Dosed
or mL/hr Only and the pump is in RUN
mode:
3 TITRATE VTBI
will replace
3 CHANGE PROGRAM
on the menu display.

B W N R

Note: Piggybacking is available only in
mL/hr Only and Continuous therapies.

Options Menu

Press |OPTIONS|

REVIEW PROGRAM
HISTORIES
KEYPAD LOCK
PUMP SETTINGS
SET CLOCK
PRINT

SPEED PROTOCOL
NEXT DOSE

OJO Uk WN R

Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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1. Introduction

LLIFor more information on: Refer to the following pages:
Programming Menu Chapter 2 Basic Operation, page 17.
Change Menu For menu item [1], refer to Starting a New Container

in Chapter 2 Basic Operation, on page 29. For
menu items [2], [3], and [4], refer to the appropriate
therapy chapter.

Options Menu Chapter 10 Options Menu, page 97.

Operating Modes

The GemStar Pump has four operating modes:

Mode ‘ Description

Help Mode The pump enters the HELP mode when is pressed during
programming or an alarm condition. The HELP mode displays
additional information about the current condition.

Programming Mode The pump enters the PROGRAMMING mode after the pump is
powered on or when is pressed.

Run Mode After is pressed, the pump enters the RUN mode, even
when not infusing.

Stop Mode When programming is complete, the pump enters the STOP

mode until is pressed.

When the programmed therapy is complete, and during certain
alarm conditions, the pump automatically enters the STOP mode.

Press to enter the STOP mode at any time, except during a
CHECK CASSETTE alarm.

Hospira GemStar Manual 430-00897-002 (Rev. 10/04) 9
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Indications for Use

Physicians or certified, licensed healthcare professionals should always oversee
infusions. Healthcare professionals should always supervise pump users and instruct
users in pump operation and troubleshooting. Instruction should include how to
prevent intravenous (I.V.) related complications, including how to prevent accidental
infusion of air.

The pump is suitable for intravenous, arterial, subcutaneous, short-term epidural
infusion and parenteral administration of general 1.V. fluids, medications, nutritional
fluids, and blood/blood products. The epidural route is recommended to provide
anesthesia or administer analgesia for periods up to 96 hours.

Note: Epidural administration of anesthetics is recommended in the continuous
mode only. Epidural administration of analgesics may be delivered by continuous,
bolus, or continuous with bolus.

4

For epidural use, the administration of drugs is restricted to those anesthetic and
analgesic drugs approved for continuous epidural administration: e.g., Chloroprocaine
Hydrochloride USP, Lidocaine Hydrochloride USP, and Morphine Sulfate Injection
USP (Preservative Free).

WARNING: Delayed respiratory depression following continuous
epidural administration of preservative-free morphine
sulfate has been reported.

For epidural administration, the following is recommended:

+ Nylon or Teflon® catheter
¢ Pump sets without Y-sites
+ Stickers for the tubing indicating ongoing administration

Note: Facilities practicing epidural anesthesia/analgesia must be staffed and
equipped to manage cardio-pulmonary resuscitation (CPR). Supplies should
include oxygen, naloxone, and other appropriate resuscitative drugs and
equipment. Monitor patients continuously (e.g., oximetry) during epidural
administration. Frequently observe patient for side effects (for up to 24 hours)
following completion of drug administration by the epidural route.

4

10 Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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Contraindications for Use

Persons who do not have the mental and physical capability or the emotional stability
to properly use the GemStar Pump should not be operate this pump.

DO NOT use the following with the GemStar Pump System:

*

*

Drugs not compatible with silicone rubber or PVC plastic
Drugs not stable under infusion conditions

Warnings and Cautions

Pay attention to the following warnings and cautions when operating the GemStar
Pump. These warnings and cautions are repeated in the manual when relevant to the
procedure being discussed. Pay attention to all alert messages.

General Warnings and Cautions

*

Federal (USA) law restricts this device to sale by or on the order of a physician or
other licensed practitioner.

Manual references to specific values are approximate only, unless indicated
otherwise. Air-in-line sensitivity values are approximate only.

When a Proximal Occlusion alarm activates, DO NOT power-off the pump.

Closely supervise patients who are likely to be adversely affected by unintended
operations and failures, including interrupted medication or fluid infusion. Ensure
provisions for immediate corrective action are available.

Regarding Drugs Used, Pump Sets, and Containers

*

USE ONLY GemStar Pump Sets with the GemStar Pump. Use of unauthorized
sets may result in injury to the patient or damage to the pump.

NEVER use drugs that are incompatible with silicone rubber or PVC plastic.

To reduce the loss of potency for drugs known to be absorbed by PVC plastic and
silicone, begin infusion as soon as practical after priming the pump set. Use of
high flow rates during infusion will minimize drug absorption.

Hospira GemStar Manual 430-00897-002 (Rev. 10/04) 11
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DO NOT use medications that are unstable under infusion conditions.
ALWAYS use connections with Luer Lock™ fittings.

To prevent contamination, use aseptic technique with all fluid-path connections.
Remove the protective coverings as assembly progresses.

ALWAYS place the flow stop in the closed position when the set is not in the
pump.

Make sure the cassette is properly installed. When properly installed, all four
cassette latches are visibly holding the cassette securely in the cassette pocket.

Ensure the tubing is behind the tubing guide (at the distal end).

Arrange tubing, cords, and cables to minimize the risk of patient strangulation or
entanglement.

NEVER use vented fluid containers (e.g., glass or rigid plastic) unless suspended
from a pole. When using a vented drip set, ALWAYS use an air-eliminating filter
OR set the air sensitivity to either ON or 2 mL.

Stop infusion if signs or symptoms of infiltration occur.

GemStar Pump Sets contain an anti-siphon valve to reduce the potential for
gravity flow at a typical 36-inch head height.

Failure to use the anti-siphon valve may result in unrestricted flow.
ALWAYS close the slide clamps before removing the cassette from the pump.

When using the pump for secondary delivery (piggybacking), ensure the fluids
being infused are chemically and physically compatible.

When infusing short-half-life drugs (i.e. those dosed with units of mcg/kg/min) at
very low rates (0.8 mL/hr or less) the rate may be too slow for that drug. Consider
using a lower drug concentration with these drugs so a pump rate above 0.8 mL/hr
can be used.

When using pre-filled vials, the system may underdeliver at low flow rates.

Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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Regarding Air-In-Line and Infusion

*

To reduce the risk of infusing air, use an air-eliminating filter when the air
sensitivity is set to OFF.

ALWAYS prime the pump set to remove all air from the cassette, tubing, and
injection site prior to connecting to the patient.

ALWAYS disconnect the pump set from the patient prior to priming or purging.

Regarding Pump Operation

*

If the pump does not perform as stated in this manual, remove the pump from
service IMMEDIATELY.

If the pump does not display the self-test or if beeps do not sound at power-on,
check all power connections and install two fresh, disposable AA batteries. If the
problem continues, contact Hospira Technical Support Operations before using
the pump.

Ensure a cassette is installed in the pump before connecting to a printer or
computer. If the pump is connected to a patient: BEFORE connecting the pump
to a computer or printer, press [STOP], close the slide clamp, and eject the
cassette. Leave the pump set connected to the patient. Install another cassette in
the pump before connecting to a printer or computer.

Disconnect the pump from the patient BEFORE performing the Operation Test.

ALWAYS connect to a grounded AC mains power source when using AC mains
power. If the quality of the grounding source is in doubt, operate the pump only
with batteries.

USE ONLY the AC mains adaptors specifically labeled for use with the GemStar
Pump.

USE ONLY the AC mains adaptor specifically labeled for use with the GemStar
Pump to charge the battery pack.

The GemStar AC Mains Adaptor is for use with the GemStar Pump or GemStar
Rechargeable Battery Pack only. DO NOT use the GemStar AC mains adaptor
with other products.

During charging, the battery pack is warm. If the battery pack becomes hot to the
touch, IMMEDIATELY unplug the AC mains adaptor and contact Hospira
Technical Support Operations.

Hospira GemStar Manual 430-00897-002 (Rev. 10/04) 13
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When removing the cord from the bottom of the pump, firmly grasp the connector
and pull straight out. DO NOT twist or bend the cord or connector.

To ensure proper pump operation, ALWAYS replace BOTH disposable batteries
with fresh, disposable AA batteries when a change is required.

ALWAYS fully close the battery door when using disposable batteries.
DO NOT use rechargeable batteries in the battery compartment.

Ensure two fresh, disposable AA batteries are installed for backup power when
using other power sources (e.g, docking station, battery pack). The pump will
continue to operate on backup power if the external power source fails.

ALWAYS avoid sources of high-intensity electromagnetic radiation (e.g., radio
transmitters, MRI scanners, microwave ovens, X-ray machines, and CAT
scanners).

Use of radio-frequency emitting devices, such as cellular telephones, 2-way
radios, and Electrical Surgical Devices (ESU), in close proximity to this device
may affect its operation.

Possible explosion hazard exists if the pump is used in the presence of flammable
anesthetics. NEVER use the pump in the presence of flammable or explosive
vapors.

Non-hazardous, low-level electrical potentials are commonly observed when
fluids are administered using infusion devices. These potentials are well within
accepted safety standards, but may create artifacts on voltage-sensing equipment,
such as ECG, EMG, and EEG machines. These artifacts vary at a rate that is
associated with the infusion rate. If the monitoring machine is not operating
correctly or has loose or defective connections to its sensing electrodes, these
artifacts may be accentuated so as to simulate actual physiological signals. To
determine if the abnormality in the monitoring equipment is caused by the
infusion device instead of some other source in the environment, set the infusion
device so that it is temporarily not delivering fluid (if clinically acceptable).
Disappearance of the abnormality indicates that it was probably caused by
electronic noise generated by the infusion device. Proper setup and maintenance
of the monitoring equipment should eliminate the artifact. Refer to the appropriate
monitoring system documentation for setup and maintenance instructions.

Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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The GemStar pump, when connected to the GemStar AC adaptor, has been tested
and found to comply with EMC/EMI limits in accordance with IEC/EN
60601-1-2 (2001). When connected to other power sources and/or optional system
components, the GemStar system complies with EMC/EMI limits in accordance
with IEC/EN 60601-1-2 (1993). These limits are designed to provide reasonable
protection against harmful interference in a typical medical installation. The
equipment generates, uses and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful
interference to other devices in the vicinity. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause
harmful interference with other devices, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by
one or more of the following measures:

+ Reorient or relocate the receiving device
+ Increase the separation between the equipment

+ Connect the equipment to an outlet on a circuit different from that to which
the other device is connected

+  Consult the manufacturer or field service technician for help

+ The use of portable and mobile RF equipment may have an impact on this and
other pieces of medical equipment

Regarding Handling and Maintenance

*

Use proper care during unpacking, installation, and operation of the pump. If the
pump is inadvertently mishandled, check connections and programmed data to
ensure there is no damage. Refer to Chapter 14 Operation Test for further
information.

ALWAYS avoid dropping or hitting the pump. If the pump is dropped or hit,
ALWAYS check connections and programmed data.

NEVER use sharp objects (e.g., fingernails, pens, pencils, or other probes) to
program or clean the pump.

Use care not to damage the silicone seals around the sensor bodies in the cassette
pocket.

To avoid mechanical or electronic damage, NEVER submerge pump in water or
other fluids and avoid fluid spills. If the pump becomes wet, dry it immediately
with a dry, lint-free cloth. Check connections and programmed data.
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1. Introduction

16

Some cleaning and sanitizing compounds may slowly degrade components made
from some plastic materials. DO NOT use compounds containing combinations of
isopropyl alcohol and dimethyl benzyl ammonium chloride (i.e., alcohol wipes).

DO NOT sterilize by heat, steam, ethylene oxide (ETO), or radiation. Apply
disinfectants to the outside surface of the pump only. DO NOT use abrasive
cleaners or materials on the pump. Using abrasive cleaners or cleaning solutions
not recommended by Hospira may result in product damage.

Please comply with local disposal and recycling regulations as appropriate for
disposable batteries, rechargeable battery packs, medical electronic components,
and pump sets.

Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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Chapter 2
Basic Operation

The minimum elements required for using the GemStar Pump are:

.

*

GemStar Pump

Appropriate power source
Appropriate GemStar Pump Set
Appropriate fluid container
Patient-access device

Overview
To start a therapy:

1

Determine the program settings. Refer to the appropriate therapy chapter for a
worksheet that may be copied and used to record program settings.

2 Select a power source. Refer to Selecting a Power Source on page 18.

3 Prime the pump set. Refer to GemStar Pump Set on page 29.

4 Load the cassette into the pump. Refer to Loading the Cassette on page 32.

5 Power-on the pump and go to the Programming Menu. Refer to Powering On
the Pump on page 24.

6 Select the appropriate optional system components, such as a bolus cord.

7 Select the therapy type and enter a program. Refer to the appropriate therapy
chapter for detailed instructions.

8 Press [START] to begin delivery.
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2. Basic Operation

Selecting a Power Source
The GemStar Pump may be powered by one or more of the following:

18

Power Source Description

[ ] [ )

GemStar Wall-mount adaptor plugs into a
AC Mains Adaptor 110 VAC mains supply.
(USA)
GemStar Tabletop adaptor plugs into a
AC Mains Adaptor 100-240 VAC mains supply. o o
(Universal)
GemStar Docking Plugs into a 100-240 VAC Volt
Station mains supply while mounted on an
I.V. pole. The docking station’s N N N
internal batteries power the
GemStar Pump during periods of
transport.
GemStar Battery The battery pack’s internal
Pack batteries power the GemStar
Pump during periods of transport o o o
or when use of AC power is not
desirable.
Disposable Batteries | Two disposable AA alkaline or
lithium batteries (available from o ° °
local sources)

CAUTION: Toensure proper pump operation, ALWAY Sreplace BOTH
batterieswith fresh, disposable AA batterieswhen a changeis
required.
DO NOT userechargeable batteriesin the battery compartment.
Ensuretwo fresh, disposable AA batteriesareinstalled for backup
power when using other power sources (e.g, docking station,

battery pack). The pump will continue to operate on backup power
if the external power source fails.

Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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2. Basic Operation

Installing Disposable Batteries

1 Flip open the tab of the battery door on
the bottom of the pump.

2 With the pump keypad facing up, hold
onto the tab and turn the battery door to
the left (counterclockwise) until it is
released from the battery compartment.

3 Pull the door free and remove any
existing batteries.

4 Install two fresh, disposable AA
batteries into the battery compartment.
Ensure the batteries are inserted as
shown.

5 Return the battery door to the battery
compartment.

6 Turn the battery door to the right
(clockwise). Ensure the battery door is
secured under the slot.

7 Flip closed the tab of the battery door to
lock in place.

Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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2. Basic Operation

Connecting the GemStar AC Mains Adaptor

1 Connect the cord of the AC mains adaptor to the connector labeled “3 VDC” on
the bottom of the pump.

2 Plug the AC mains adaptor into a standard wall outlet.

CAUTION: ALWAYS connect to a grounded AC mains power source when
using the AC mains adaptor. USE ONLY AC mains adaptors
specifically labeled for use with the GemStar Pump.

When removing the cord from the bottom of the pump, firmly
grasp the connector and pull straight out. DO NOT twist or bend
the cord or connector.

POWER
Note: The green LED | XY on the pump remains lit when connected to AC mains
power.

'
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2. Basic Operation

'

“~

Using the GemStar Rechargeable Battery Pack

Use the GemStar AC Mains Adaptor (List 13026-01 [USA] or 13072-01 [Universal])
to recharge the GemStar Battery Pack.

CAUTION: ALWAYS connect to a grounded AC mains outlet when using AC
mains adaptor.

Use only AC mains adaptors specifically labeled for use with the
GemStar Pump to charge the battery pack.

During charging, the battery pack is warm. If the battery pack
becomes hot to the touch, IMMEDIATELY unplug AC mains
power and contact Hospira Technical Support Operations.

Note: A charged battery pack will last approximately 24 hours when the pump is
infusing at rates less than 125 mL/hr.

To connect the battery pack:

1 Line up the connectors on the top of the battery
pack with the holes on the bottom of the pump.

2 Snap the battery pack into place.

To release the battery pack:
1 Press the release button on the battery pack.
2 Pull the battery pack straight out from the pump.

Note: When the pump is connected to the battery
pack, the pump’s green LED flashes and the battery

pack light is off-

When the pump is connected to the battery pack at
power-on, the pump displays USING EXT BATT.
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2. Basic Operation

To recharge the battery pack:

1 Plug the pin connector of the AC mains adaptor into the port on the bottom of the
battery pack.

2 Plug the AC mains adaptor into a standard wall outlet.

3 Leave the battery pack connected to the AC mains adaptor for at least 8 hours to
recharge the battery pack

CAUTION: When removing the cord from the bottom of the pump, firmly
grasp the connector and pull straight out. DO NOT twist or bend
the cord or connector.

Note: The battery pack light is yellow while the battery pack is charging. When the
battery pack is charged, the battery pack light is green.

X
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. Basic Operation

Connecting to the GemStar Docking Station

Connecting the Pump

1

2

3

4

Mount the docking station to the I.V. pole and tighten
the knob.

Line up the connectors on the bottom of the pump with
the connectors on the docking station.

Slide the pump into the docking station until it snaps
into place.

Connect the docking station to AC mains power.

Note: The docking station light is yellow while the docking station is charging. When
the docking station is charged, the light is green.

Disconnecting the Pump

To remove the pump:

1

2

Press the release button on the top of the docking
station.

Slide the pump out.

Hospira GemStar Manual 430-00897-002 (Rev. 10/04)

%

23

4

ﬁ

T



@E 430-00897-002.book Page 24 Friday, October 22, 2004 2:38 PM

4

2. Basic Operation

Powering On the Pump

CAUTION: If the pump does not display the self-test or if beeps do not sound at
power-on, check all power connections and install two fresh,
disposable AA batteries. If the problem continues, contact Hospira
Technical Support Operations before using the pump.

“ Note: If a cassette is not properly loaded, the pump will alarm after the power-on test is
- complete.

1 Press [ON/OFF] to power-on the pump. The pump
completes a self-test and displays the time and date. No
response is required.

GEMSTAR 7
UNIT SELF-TEST
TIME IS 10:00 AM
FRI, JUN 11, 04

Note: The self-test takes approximately 30 seconds to complete. If the pump is
locked, lock symbols appear at the beginning and end of the second line:
R UNIT SELF-TEST @.

'

2 The pump checks for available power sources. Respond to the display message as
shown in the following table:.

Display Message Power Source(s) User Response

No message displays | AC power and No response required, the pump goes
disposable batteries. |to the next step.

LOW BATTERIES AC power and weak |Press to confirm.
(low voltage)

ENTER TO CONFIRM disposable batteries; Power-off the pump and install two
or weak disposable fresh, disposable AA batteries as a
batteries only. backup power source.

NO INTERNAL BATT |No disposable Press to confirm.
batteries or dead

NO POWER LOSS )
ALARM AVATLABLE |disposable batteries; Power-off the pump and install two

ENTER TO CONFIRM |and external power. fresh, disposable AA batteries as a
backup power source.

24 Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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2. Basic Operation

Display Message Power Source(s) User Response

USING BATTERIES |Disposable batteries |Press @ to confirm.

only.
ENTER TO CONFIRM If an external power source is in use,

ensure the connections are secure.

USING EXT BATT External batteries Press to confirm.

(docking station

ENTER TO CONFIRM |pattery or battery If an AC mains adaptor is in use,
pack) and disposable |€nsure the connections are secure.
batteries.

N
Note: To power-off the pump, press and hold until the display clears. The pump
cannot be powered off during a CHECK CASSETTE alarm (except during
PROGRAMMING mode). Refer to Chapter 12 Troubleshooting for information on
clearing a CHECK CASSETTE alarm.

s

L] For more information on: Refer to the following pages:

Setting the clock Set Clock in Chapter 10 Options Menu, on page 108.

Locking the keypad Keypad Lock in Chapter 10 Options Menu, on
page 104.
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2. Basic Operation

Accessing the Programming Menu

After power-on, the pump checks its memory for a stored program. Respond to the
display message as shown in the following table:

Display Message ‘ Condition ‘ User Response
The pump displays the Pump memory [»  To enter a new program: Select a therapy
Programming Menu. is clear. from the Programming Menu and enter a

new program. Refer to the appropriate
therapy chapter for instructions.

1 RESUME PROGRAM A program is » To continue the current program, press [1].

2 CLR PROG&SHIFT currently stored
3 CLR PROG, SHIFT in pump » To reset the current program:
AND HISTORY memory.
1 Press [1].

2 Press [CHANGE] to display the Change
Menu and select NEW CONTAINER.

»  To enter a new program and clear shift
totals: Press [2]. The pump clears the
program and shift totals from memory and
enters PROGRAMMING mode.

» To enter a new program, clear shift totals,
and clear history: Press [3]. The pump
clears the program, shift totals, and history
from memory and enters PROGRAMMING
mode.

' Tip: To enter a new program when the pump is already powered on:
1 Press [STOP] to place the pump in STOP mode.

2 Press [CHANGE] to display the Change Menu.

3 Select NEW PROGRAM. The pump clears the current program and
displays the Programming Menu.

26 Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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2. Basic Operation

Programming the Pump

Programming Overview

The pump’s menu system provides step-by-step guidance through all of the
programming steps. Refer to the appropriate therapy chapter for detailed
programming instructions.

Programming worksheets are available at the end of each therapy chapter. Each
worksheet lists the minimum and maximum value (program range) allowed for that
therapy. If a number outside of the program range is entered, the pump displays the
minimum or maximum value allowed.

1 Select the desired therapy from the Programming Menu.
2 Respond to display messages and enter requested values.

Note: Program entries can be changed any time before the Program Review is
complete. Press [BACK-UP] to return to previous program displays and make
changes as desired.

3 Review the program, if required. Press @ to begin review. Press [YES/ENTER]
when done.

4 SAVING PROGRAM displays. The pump stores the program in memory and then
enters STOP mode.

Tip: If you enter an incorrect number during programming, press [CHANGE]
BEFORE pressing [YES/ENTER] to reset the number to zero. Then enter the
correct number.
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2. Basic Operation

Programming Tips

The following table explains how to use the keypad during programming:

Key Function

[0]-[9] Press the number keys to select menu items and to enter numeric values.

Note: Some menu items require pressing two number keys to select that items.

For example, when selecting a unit of measure for a weight dosed program, the
menu may display as:

01 mcg/kg/mg
02 mcg/kg/hr
03 mcg/kg/min
04 mg/kg/min

To select mg/kg/min, press [0][4].

Press to accept entries or to continue when done viewing a display.

HELP Press during programming and alarm conditions to display information
about the current condition.

@ @ Press @ or @ to scroll through display messages.

Press @ to insert a decimal point in a numeric value.

CHANGE When entering a numeric value during programming, press before

pressing to reset the value to zero.

Press to return to a previous display, to exit the Options Menu, or to exit
the HELP mode.

BACK-UP

28 Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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2. Basic Operation

Starting a New Container

" Note: The NEW CONTAINER function is not available when the pump isin FULL Lock.
A ) Refer to Chapter 10 Options Menu, page 97 for more information on locking the

keypad.
To repeat the current program with a new container:
1 Fromthe STOP mode, press [CHANGE] to display the Change Menu.

2 Sedlect NEW CONTAINER from the Change Menu. The pump displays NEW
CONTAINER for several secondsand clears the amount infused from memory.

3 Review the program. Press (W) to begin review.
4 Press[START] to begin delivery.

GemStar Pump Set

The GemStar Pump Set is a sterile, single-use, disposable pump set. It isdesigned for
one-time use only and should be properly discarded after use.

Fluid path and areas beneath undisturbed protective set

covers are sterile and nonpyrogenic in the intact unit STERILE] @
package.

Contact a Hospira representative for more information on selecting the appropriate
pump set configuration. Additional disposable components, such as air-eliminating
filters and extension sets, may be added to the line as required. To use a GemStar
Pump Set, follow the instructions included with the set.

Note: GemSar Pump Sets contain an anti-siphon valve to reduce the potential for
gravity flow at a typical 36-inch head height.

'

False occlusion alarms and fluid delivery inconsistencies may occur when pumping
viscous fluids in microbore tubing at rates greater than 500 mL/hr.
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2. Basic Operation

A typical GemStar Pump Set is shown below:

3““‘_»

@QQIQQQ -
e

1 Piercing Pin 6 Tubing

2 Proximal End 7  Slide Clamp

3 Cassette 8 Secure Lock

4 Flow Stop (open / close ) 9  Anti-Siphon valve
5 Distal End

30 Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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2. Basic Operation

WARNING: ALWAYS prime the pump set to remove air from the
cassette, tubing, and injection sites prior to connecting to
the patient. ALWAYS disconnect the pump set from the
patient prior to priming or purging. Arrange tubing, cords,
and cables to minimize the risk of patient strangulation or
entanglement.

Failure to use the anti-siphon valve may result in
unrestricted flow.

CAUTION: USE ONLY GemStar Pump Sets with the GemStar Pump. Use of
unauthorized sets may result in injury to the patient or damage to
the pump.

To prevent contamination, use aseptic technique with all fluid-path
connections. Remove protective coverings as assembly progresses.

Opening the Pump Set

1 Open the GemStar Pump Set package and
remove the contents.

2 Remove the protective covers from the fluid
container administration port and the pump set.
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2. Basic Operation

A

Loading the Cassette
1 Identify the four black cassette latches inside the cassette pocket.

CASSETTE
LATCHES

CASSETTE
LATCHES
2 Line up the cassette as shown 3 Insert the cassette into the cassette
(with the flow stop button facing pocket by pushing firmly along the
the pump). entire cassette until it isfirmly
seated.

32 Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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2. Basic Operation

4 Verify that all four cassette latches
are securely holding the cassette.

)

a »
CASSETTE CASSETTE
LATCHES LATCHES
[ D

CAUTION: Ensure the cassette
is properly installed. When
properly installed, all four
cassette latches are visibly
holding the cassette securely in
the cassette pocket.

5 Place the tubing in the
tubing channel.

Note: Ensure the tubing is behind

"4 the tubing guide (at the distal
end).

" Note: The pump cannot be

A powered off during a CHECK

CASSETTE alarm (except during
PROGRAMMING mode). Refer to
Chapter 12 Troubleshooting for
information on clearing a CHECK
CASSETTE alarm.

Releasing the Cassette

1 Close the CAIR® (roller) clamp or

slide clamp on the distal line.

2 Push down on the cassette release
(large black button) on the top of

the pump.

3 Remove the cassette.

" Note: When the cassette is
N, released from the pump, the

cassette flow stop automatically

closes, preventing free flow.
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2. Basic Operation

Priming a GemStar Pump Set

Priming Pump Sets WITHOUT a Drip Chamber

WARNING: Failure to use the anti-siphon valve may result in
unrestricted flow.

1 Push down on the flow stop to 4 Invert the cassette approximately
close the cassette. 45°.

2 Hold the container with the 5 While holding the rotated cassette,
administration port toward the squeeze or roll the container to
ceiling and insert the piercing pin. remove air from the container and

cassette.

3 Push down on the flow stop () to

open (priming position) the 6 Return the cassette to the upright
cassette. position. Continue priming until
fluid fills the tubing.
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2. Basic Operation

7 Push down on the flow stop to

close the cassette.

4

CAUTION: Ensure all four
cassette latches are clearly
visible after the cassette is
installed. Refer to Loading the

Cassette on page 32.

2

CASSETTE
LATCHES

KA

CASSETTE
LATCHES

Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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Note: Ensure the tubing is behind
the tubing guide (at the distal
end).

Bottom

Tubing
Guide

CAUTION: When priming is
complete, ensure no fluid flows
at the distal end of the pump set.
If flow is observed, DO NOT use
the pump set.

Connect the pump set to the
patient-access device.
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2. Basic Operation

Priming Pump Sets WITHOUT a Drip Chamber Using the PURGE Key

WARNING: Failure to use the anti-siphon valve may result in
unrestricted flow.

'\ Note: The PURGE function is available only if there is a program in the pump.

1 Push down on the flow stop to CAUTION: Ensure all four

close the cassette. cassette latches are clearly
visible after the cassette is
installed. Refer to Loading the
Cassette on page 32.

NS N
= I
~\ TS it
2 Hold the container with the
administration port toward the il

ceiling and insert the piercing pin.
Note: Ensure the tubing is behind
the tubing guide (at the distal

V4 G@ end).

3 Load the cassette.

\_/

4

Bottom

Tubing
Guide

=,

4 Program desired therapy.
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2. Basic Operation

5 Press [PURGE].

6 The pump displays PRIME THE
SET? Press [YES/ENTER].

7 While holding the container with
the administration port toward the
ceiling, press and hold [PURGE].

Note: Purge rate is 250 mL/hr.
The pump purges for up to 2
minutes each time you press
and hold [PURGE].

Continue using the [PURGE]
key until fluid fills the tubing.
Ensure all air is removed
from the container, cassette,
and tubing.

CAUTION: When priming is
complete, ensure no fluid
flows at the distal end of the
pump set. If flow is observed,
DO NOT use the pump set.

8 Connect the pump set to the
patient-access device.

4
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Priming Pump Sets WITH a Drip Chamber

WARNING: Failure to use the anti-siphon valve may result in
unrestricted flow.

When using a vented chamber, ALWAYS use an
air-eliminating filter OR set the air sensitivity to
either ON or 2 mL.

1 Push down on the flow stop to 4 Push down on the flow stop to
close the cassette. open (priming position) the
cassette.

2 [Insert the piercing pin into the
container. Suspend the container 5 Ensure the CAIR® (roller) clamp
on an [.V. Pole. is open.

T r

3 Squeeze the drip chamber until 6 Invert the cassette approximately
filled halfway. 45°.

74|
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While holding the rotated cassette,
remove air from the container and
cassette.

EX 7=

Return the cassette to the upright
position. Continue priming until
fluid fills the tubing.

Push down on the flow stop to
close the cassette.

d

Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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CAUTION: Ensure all four
cassette latches are clearly
visible after the cassette is
installed. Refer to Loading the
Cassette on page 32.

3

CASSETTE CASSETTE

»
LATCHES LATCHES
»

A

Note: Ensure the tubing is behind
the tubing guide (at the distal
end).

Bottom

Tubing
Guide

ek

CAUTION: When priming is
complete, ensure no fluid flows
at the distal end of the pump set.
If flow is observed, DO NOT use
the pump set.

11 Connect the pump set to the

patient-access device.
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Priming Pump Sets WITH a Drip Chamber Using the PURGE Key

WARNING: Failure to use the anti-siphon valve may result in
unrestricted flow.

When using a vented set, ALWAYS use an air-eliminating
filter OR set the air sensitivity to either ON or 2 mL.

'\ Note: The Purge function is available only if there is a program in the pump.

1 Push down on the flow stop to 4 Push down on the flow stop (%) to
close the cassette. open (priming position) the
cassette.

2 Insert the piercing pin into the

container. Suspend the container 5 Ensure the CAIR® (roller) clamp
on an L.V. Pole. is open.

%A
% 7

3 Squeeze the drip chamber until
filled halfway.

T
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2. Basic Operation

'

6 Load the cassette.

CAUTION: Ensure all four
cassette latches are clearly
visible after the cassette is
installed. Refer to Loading the
Cassette on page 32.

a
CASSETTE CASSETTE
LATCHES LATCHES
(]

»
\_/

Note: Ensure the tubing is behind
the tubing guide (at the distal
end).

“~

Hospira GemStar Manual 430-00897-002 (Rev. 10/04)

7 Program the desired therapy.
8 Press [PURGE].

9 The pump displays PRIME THE
SET? Press [YES/ENTER].

10 Press and hold [PURGE].

Note: Purge rate is 250 mL/hr.
The pump purges for up to 2
minutes each time you press and
hold [PURGE].

Continue using the [PURGE] key
until fluid fills the tubing. Ensure
all air is removed from the
container, cassette, and tubing.

CAUTION: When priming is
complete, ensure no fluid flows
at the distal end of the pump set.
If flow is observed, DO NOT use
the pump set.

11 Connect the pump set to the
patient-access device.
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2. Basic Operation

Priming Pump Sets Using Pre-filled Vials

WARNING: Failure to use the anti-siphon valve may result in
unrestricted flow.

CAUTION: When using pre-filled vials, the system may underdeliver at low

flow rates.
1 Ifusing a pump set with the 4 Connect the pump set to a Hospira
Y-extension, use the slide clamp to pre-filled vial and injector.
close off the KVO (Keep Vein
Open) side of the tubing.

> l
5 Push down on the flow stop (%) to
open (priming position) the

2 Open the upper and lower slide cassette.
clamps.

' 4

3 Push down on the flow stop to
close the cassette.
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6 Hold the vial and set upright 9 Ifthe set includes a KVO

(vertically) on a flat surface with Y-extension, close the slide clamp
the pump set extending from the below the pre-filled vial and open
top. the slide clamp on the KVO side.

7 Slowly push down on the injector
until fluid flows at the distal end of
the tubing, which indicates that all
air is cleared from the vial,
injector, cassette, and tubing.

Prime the KVO Y-extension.

8 Push down on the flow stop to

close the cassette. CAUTION: Ensure all four
cassette latches are clearly
visible after the cassette is
installed. Refer to Loading the
Cassette on page 32.

’: 1
CASSETTE CASSETTE
LATCHES LATCHES
(] D
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2. Basic Operation

” Note: Ensure the tubing is behind
A the tubing guide (at the distal
end).

CAUTION: When priming is
complete, ensure no fluid flows
at the distal end of the pump set.
If flow is observed, DO NOT use
the pump set.

11 Connect the pump set to the
patient-access device.

44 Hospira GemStar Manual 430-00897-002 (Rev. 10/04)

%

ﬁ




‘ 6%% 430-00897-002.book Page 45 Friday, October 22, 2004 2:38 PM

-

.

2. Basic Operation

Priming Pump Sets with Extensions

WARNING: Failure to use the anti-siphon valve may result in
unrestricted flow.

1 Push down on the flow stop to 4 Invert the cassette approximately
close the cassette. 45°.

5 While holding the rotated cassette,
squeeze or roll the container to
remove air from the container and
cassette.

2 Hold the container with the
administrative port toward the
ceiling and insert the piercing pin.

3 Push down on the flow stop . to
open (priming position) the
cassette.

6 Return the cassette to the upright
position. Continue priming until
fluid fills the tubing.

()
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2. Basic Operation

% ‘ 2>

7 Push down on the flow stop to
close the cassette. LN
4

8 Connect the extension set to the
pump set.

9 Load the cassette.

CAUTION: Ensure all four

cassette latches are clearly

visible after the cassette is LY
installed. Refer to Loading the )
Cassette on page 32.

)

CASSETTE
LATCHES

a
CASSETTE
LATCHES
(]

Note: Ensure the tubing is behind
the tubing guide (at the distal
end).

Tubing
Guide

10 Program the desired therapy.
11 Press [PURGE].

HELP

=

12 The pump displays PRIME THE
SET? Press [YES/ENTER].

13 Press and hold [PURGE].

Note: Purge rate is 250 mL/hr.
The pump purges for up to 2
minutes each time you press and
hold [PURGE].

Continue using the [PURGE] key
until fluid fills the tubing. Ensure
all air is removed from the
container, cassette, and tubing.

CAUTION: When priming is
complete, ensure no fluid flows
at the distal end of the pump set.
If flow is observed,

DO NOT use the pump set.

14 Connect the pump set to the
patient-access device.
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Chapter 3

Total Parenteral Nutrition (TPN)

Therapy Features and Specifications
This therapy allows programming of Total Parenteral Nutrition (TPN) protocols.

+ Taper Up and Taper Down may be programmed to gradually increase and
decrease the infusion rate at the beginning and end of a therapy. If Taper Down is

selected during programming, the pump allows auto tapering if the continuous

delivery is stopped before the programmed volume has been infused.

+ Set an optional KVO (Keep Vein Open) during programming.

Tip: The Programming Worksheet at the end of this chapter lists the minimum and

' maximum values allowed for this protocol. Use copies of the programming
worksheet to record program values before programming the pump.

TPN Programming Tips

The following table explains how to use the keypad during TPN programming:

Key
[0] - [9]

‘ Function

Selects menu items and
enters numeric values.

Key

@@

‘ Function

Scrolls through program
review and help messages.
The up arrow inserts a
decimal point in a numeric
value.

Accepts entries or continues
when done viewing a display.

CHANGE

Clears a numeric value
(resets to zero) during
programming.

Displays information during
programming and alarm
conditions.

BACK-UP

Returns to a previous display,
exits the Options Menu, and
exits the HELP mode.

.
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3. Total Parenteral Nutrition (TPN)

'

'

'

X

TPN Programming

1
2
3

8
9

Select TPN from the Programming Menu.
Select the TPN delivery mode.
Enter the total VTBI (Volume To Be Infused).

Note: Maximum VTBI is 9600 mL minus any taper amount.

Enter the Taper Up and Taper Down times (if applicable).

Note: Time is entered in hours:minutes (00:00). For one hour thirty minutes,
press [1] [3] [0], not [9] [0].
Enter the total time to infuse.

Enter the KVO rate. If no KVO is desired, press [YES/ENTER] while the value
displayed is zero.

Note: KVO runs after Taper Down until the total container is
infused.

Enter the container size (VITBI + KVO).

Note: If KVO is programmed, increase the container size to accommodate the
desired KVO volume.

Select the air sensitivity, if required.

Review the program. Press @ to begin review.

10 If using the PURGE key to prime the pump set, press [PURGE] now.

WARNING: ALWAYS disconnect the pump set from the patient before

priming or purging.

48
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3. Total Parenteral Nutrition (TPN)

Changing a TPN Program

Can be changed

Can be changed at any Cannot be

time changed
before is pressed g

.

.

VTBI « KVO rate « Delivery mode
Taper times * Increase container size

only
« Air sensitivity

Total TPN time

Note: You cannot change a programwhen the pumpisin FULL or CONTAINER
Lock.

To change a program:

1
2

From the STOP mode, press [CHANGE] and select CHANGE PROGRAM.

As each message displays, make the desired changes or press [YES/ENTER] to
accept the current setting.

Review the program. Press ® to begin review.
Press [START] to begin infusion.
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3. Total Parenteral Nutrition (TPN)

TPN Auto Taper Down

Auto Taper Down is available only if a Taper Down time was entered during
programming. Auto Taper Down may be activated when the continuous delivery
portion of a TPN with Taper Down protocol is stopped. Auto Taper Down is not
available while the pump is in an alarm condition.
1 Press [STOP] during TPN delivery.

The pump displays DO YOU WANT AUTO TAPERING?

*  Press [NO] to return to the STOP mode. Then press [START] to continue
therapy.

e Press [YES/ENTER] to set Auto Taper Down.
2 Enter the Auto Taper Down time.

The maximum Auto Taper Down time is three hours OR two times the remaining
volume divided by the continuous infusion rate, whichever is less.

Note: Time is entered in hours:minutes (00:00). For one hour thirty minutes,
press [1] [3] [0], not [9] [0].

3 Press [YES/ENTER] to return to the RUN mode, then press [START] to begin Auto
Taper Down.

'
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3. Total Parenteral Nutrition (TPN)

GemStar®
TPN Programming Worksheet
GIVE:
Parameters Selections and/or Values to be Programmable
Entered Ranges
Therapy TPN N/A
Delivery Mode a Continuous N/A
Q Continuous + Taper Down
Q Continuous + Taper Up
Q Continuous + Taper Up and Down

VTBI (Volume To Be

Infused)
mL 1-9600 mL*
Taper Up Q No
Q VYes hrs:min 1 min-3hrs
Taper Down Q No
a Yes hrs:min 1 min - 3 hrs**
Total Time to Infuse
hrs:min 1 min-24 hrs

KVO (Keep Vein Open) | O No KVO Rate: 0.0

O Yes KVO Rate: 1.0 - 5.0 mL/hr

Container Size

(VTBI + KVO) mL 9999 mL max

Air Sensitivity a On Alarms at approx. 0.5 mL of air | N/A
Q 2mL Alarms at approx. 2 mL of air
a off No alarm

*  Maximum VTBI is 9600 mL minus any taper amount.

**  Programmable ranges for taper down are 1 minute to 3 hours OR 2 times the
remaining volume divided by the continuous delivery rate, whichever isless.
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Chapter 4
Pain Management

Therapy Features and Specifications

Thistherapy allows programming of a continuous only, bolus only, or continuous with
bolus delivery.

+ InContinuous + Bolus protocols, you can enter zero for either the continuous rate
or the bolus dose when entering or changing a program. The continuous rate and
bolus dose cannot be zero at the sametime.

+ Thedefault bolus delivery rateis 125 mL/hr.

+ A loading dose may be set during programming, which can be delivered after
programming and priming are complete. The default loading dose rate is 125
mL/hr.

+ Priming using [PURGE] isonly alowed before [START] is pressed or after one of
the following events occur:

+ Complete Review of New Program
+ New Container
+ Air-in-Line Alarm

CAUTION:  When using pre-filled vials, the system may under deliver at low
flow rates.

Note: New Container isallowed only when at least 1/2 of the container volume has
been infused or 1 hour has elapsed since starting the infusion.

The use of a lockbox is recommended with pain management protocols. Refer to
Chapter 15 Optional System Components, page 153, for instructions on using a
lockbox with the GemSar Pump.

Tip: The Programming Worksheet at the end of this chapter lists the minimum and
maximum values allowed for this protocol. Use copies of the programming
worksheet to record program values before programming the pump.
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4. Pain Management

Pain Management Programming Tips

The following table explains how to use the keypad during pain management

programming:

Key
[0] - [9]

Function

Selects menu items and
enters numeric values.

Key

N2

‘ Function

Scrolls through program
review and help
messages. The up arrow
inserts a decimal point in
a numeric value. The
down arrow toggles units
of measure when entering
concentrations.

Accepts entries or
continues when done
viewing a display.

CHANGE

Clears a numeric value
(resets to zero) during
programming.

Displays information
during programming and
alarm conditions.

BACK-UP

Returns to a previous
display, exits the Options
Menu, and exits the
HELP mode.

Pain Management Programming

1 Select PAIN MANAGEMENT from the Programming Menu.

2 Select the

Note: If Continuous + Bolus is selected, the continuous delivery rate or bolus dose
can be set to zero through the CHANGE menu without reprogramming the pump.

delivery mode.

3 Select the unit of measure and concentration as required.

54
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4. Pain Management

8
9

Set the continuous delivery rate.

Note: The pump only delivers in increments of 0.1 mL. Values entered in a Pain
Management therapy may be rounded to the nearest 0.1 mL. For example, at a
concentration of 15 mg/mL, a rate of 5 mg rounds to 4.5 mg.

Smg=0.333 mL
4.5mg =03 mL

When a value is rounded, the pump sounds four quick beeps, displays ROUNDING
for a few seconds, and then displays the rounded value. Press [YESIENTER] to
accept the rounded value and continue to the next step.

Program a loading dose as required.

Program a bolus dose with lockout time and dose limit as required.

Regarding a 1-Hour or 4-Hour Dose Limit: The hour dose limit is the
maximum volume (continuous plus bolus or bolus only amount) that can be
delivered over the selected period. When the programmed dose limit is reached,
the continuous delivery stops and a new bolus is not allowed. As the oldest
delivery amounts age out of the 1-hour or 4-hour dose limit record, the pump
accepts bolus requests or resumes continuous delivery (if programmed).

Note: If a 1-hour or 4-hour dose limit is programmed, a bolus in progress will stop
when the amount infused reaches the dose limit.

Loading doses are included in a 1-hour or 4-hour dose limit. A dose limit in effect
could prevent the delivery of a loading dose.

If programmed in units of mcg or mg, the line displaying the units flashes. Enter
the container size in proper unit measure.

Note: To enter the total in mL when programming a concentration, press () to
move to the mL line. Enter the mL value when wL flashes on the display.

Select the air sensitivity, if required.

Review the program. Press () to begin review.

10 If using the PURGE key to prime the pump set, press [PURGE] now.

WARNING: ALWAYS disconnect the pump set from the patient before

priming or purging.
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4. Pain Management

Bolus Delivery

56

Set bolus doses and delivery limits during programming. The default bolus dose
delivery rate in a pain management protocol is 125 mL/hr.

A bolus cord is available for patient bolus requests. Refer to Connecting the Bolus
Cord in Chapter 15 Optional System Components, on page 156, for more
information.

Delivering a Bolus Dose

From the RUN mode, press either the bolus button [+] on the top of the pump or the
button on the end of the bolus cord to begin bolus dose delivery. The pump flashes
BOLUS DELIVERY on the display and the amount infused accrues as the delivery
progresses.

When the bolus dose is complete, the pump does the following:

+ Records the bolus request and delivery amount to the event and bolus history logs
+ Adds the delivered boluses to the total bolus amount in the program amounts

+ Resets the bolus lockout time (if applicable) and ignores other bolus requests until
the lockout time has elapsed

+ Continues programmed infusion
Note: ALL bolus requests are recorded to the event and bolus history logs.

If the bolus delivery does not start, it could be locked out by one of the following
conditions:

+ Bolus lockout period

+ Loading dose delivery in progress
+ Bolus dose delivery in progress

+ Bolus per-hour limit

¢ 1-hour or 4-hour dose limit
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4. Pain Management

Bolus Dose Interruptions

Bolus deliveries may be interrupted by:

¢ Pressing [STOP]

¢ An alarm condition

To continue bolus delivery after an interruption:

1 Press [START]. The pump displays COMPLETE BOLUS NOW?

2 Respond as follows:

To do this: ‘ Press this key: ‘ Bolus lockout time is set to:
Deliver the remaining The time of delivery completion
bolus amount %

Clear the undelivered The time the bolus was

bolus amount interrupted

Loading Dose Delivery

You can set a loading dose during programming, if desired. A loading dose can be
delivered after programming and priming are complete.

'\4 Note: Loading dose amounts are included in a 1-hour or 4-hour dose limit.

Delivering a Loading Dose

1 After priming and programming, press [START].

2 The pump displays DELIVER THE LOADING DOSE NOW? Press [YES/ENTER] to
begin loading dose.

When the loading dose is complete, the pump does the following:

+ Automatically begins programmed infusion

+ Records the dose amount to the history log

+ Resets the bolus lockout time (if applicable) and ignores other bolus requests until
the lockout time has elapsed
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4. Pain Management

Loading Dose Interruptions

Loading dose deliveries can be interrupted by:

¢ Pressing [STOP]

¢ An alarm condition

To continue a loading dose:

1 Resolve the interruption.
2 Press [START]. The pump displays COMPLETE THE LOADING DOSE?

3 Respond as follows:

To do this: ‘ Press this key:

Deliver the remaining loading dose amount @
Clear the remaining loading dose amount -

Changing a Pain Management Program

Can be changed at any time ‘ Cannot be changed
* Delivery rate » Container size * Delivery mode

* Bolus « Air sensitivity * Unit of measure

» Bolus lockout * Dose limit amount » Concentration

* Dose limit type

Note: You cannot change a program when the pump is in FULL or CONTAINER
Lock. With a RATE CHANGE Lock, the continuous delivery rate and bolus amount
can be changed within the set ranges.

X

Although the delivery mode cannot be changed, if Continuous + Bolus is
programmed, the continuous rate or bolus amount can be changed to zero. The
minimum values set with a RATE CHANGE Lock could restrict this function.
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4. Pain Management

To change a program:
1 From the STOP mode, press [CHANGE] and select CHANGE PROGRAM.

2 As each message displays, make the desired changes or press [YES/ENTER] to
accept the current setting.

3 Review the program. Press (W) to begin review.
4 Press [START] to begin delivery.
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4. Pain Management

GemStar®
Pain Management Programming Worksheet
GIVE:
Parameters Selections and/or Values to be Programmable Ranges
Entered
Therapy Pain Management N/A
Delivery Mode | O Continuous N/A
Q Bolus Only
Q Continuous + Bolus
Unit of a Concentration: mg/mL 0.1 - 100 mg/mL
Measure
O Concentration: mecg/mL 1-1000 mcg/mL
o mL
Continuous 0.1 - 2500 mg/hr
Rate 1 - 25000 mcg/hr
0.1-25.0 mL/hr
Loading Dose | d No 0.1 -2500 mg
1-25000 mcg
Q Yes Amount: 0.1-25.0 mL
Bolus Dose 0 - 2500 mg
0 - 25000 mcg
0-25.0mL
Bolus Lockout
minutes 5-999 min

Optional Dose | O

4-hour limit Amount:

4X rate - 400 mL, 40000 mg,

a
a

2mL Alarms at approx. 2 mL of air
Off No alarm

Limit 400000 mcg*
Q 1-hour limit Amount: Rate - 100 mL, 10000
mg, 100000 mcg*
O # boluses/hourNumber: 1-12
O Nodose limit
*For continuous plus bolus
delivery.
Note: For Bolus Only, the 1-hour or 4-hour dose limit minimum is 1 bolus dose.
Container Size 0.1-99999 mg
1-9999000 mcg
0.1-9999 mL
Air Sensitivity a On Alarms at approx. 0.5 mL of air | N/A
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Chapter 5
Intermittent

Therapy Features and Specifications
This therapy allows programming of multiple doses at regular intervals.

+ Optional KVO (Keep Vein Open) can be set during programming.

+ The pump can be disconnected from the patient between dose deliveries. A call
back alarm can be set to alert the patient or caregiver to reconnect the pump before
the next scheduled delivery begins. The pump must remain powered on for the
call back alarm to function. At the set time before each dose, the pump produces
an audible and visual alarm and flashes START on the display.

Tip: The Programming Worksheet at the end of this chapter lists the
minimum and maximum values allowed for this protocol. Use copies of the
programming worksheet to record program values before programming the
pump.

Intermittent Programming Tips

The following table explains how to use the keypad during intermittent programming:

Key ‘ Function Key ‘ Function
[0] - [9] Selects menu items and Scrolls through program
enters numeric values. @ @ review and help

messages. Toggles
between AM and PM in
time-based entries. The
up arrow inserts a decimal
point in numeric values.

Accepts entries or Clears a numeric value
% continues when done CHANGE (resets to zero) during
viewing a display. programming.

Displays information Returns to a previous
HELP during programming and BACK-UP display, exits the Options
alarm conditions. Menu, and exits the
HELP mode.
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5. Intermittent

Intermittent Programming

62

1
2
3

Select INTERMITTENT from the Programming Menu.
Enter the dose amount in mL.

Enter the infusion time for each dose in hours:minutes (00:00).
For example, press [4] [0] if each dose is to deliver for 40 minutes.
Enter the frequency of dose deliveries.

For example, press [4] [0] [0] to start a dose every four hours.
Enter the total number of doses in the container.

To determine the number of doses in the container, divide the volume in the
container by the dose amount.

Enter the KVO rate in mL.

KVO delivers before a delayed start time, between doses, and after the last dose
until the total container is infused.

If no KVO is desired, press [YES/ENTER] while the value displayed is zero.
Enter the container size.

The pump automatically calculates the minimum container size required to deliver
the number of programmed doses and KVO between doses.

Note: If KVO is desired before a delayed start, increase the container size to
include the desired KVO volume.

Select the air sensitivity, if required.

Note: DO NOT press [YES/ENTER] after selecting the air sensitivity. If
[YES/IENTER] is accidentally pressed and a call back alarm is not desired, press
[BACK-UP] fo return to the beginning of step 9 and press [NO].

The pump displays SET CALL BACK ALARM FOR NEXT DOSE?
* Press [NO] if you do not want to set the call back alarm.
*  Press [YES/ENTER] to set the call back alarm.

Enter the time before the next dose that the alarm should sound. For example,
press [1] [0] to set the alarm to sound 10 minutes before the start of the next
scheduled delivery.
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5. Intermittent

Note: When programming the call back alarm, be sure to allow enough time for the
patient or caregiver to reconnect the pump to the patient and to press[START]
BEFORE the scheduled dose start time.

N3
A

10 The pump displays the current time.
» If thedisplayed timeis correct, press [YES/ENTER].
* To set the clock, press [OPTIONS].
11 The pump displaysthe current time and START NOW?
» Press[YES/ENTER] to begin delivery when the pump enters the RUN mode.

*  Press[NO] to set adelayed start time. The pump displays SET START TIME.
Enter the desired start time and press [YES/ENTER] when done.

L Y Note: When entering the timein 12-hour format, press @ or ¥ to toggle between
4 AM and PM.

12 Review the program. Press @ to begin review.
13 If using the PURGE key to prime the pump set, press [PURGE] now.

WARNING: ALWAYS disconnect the pump set from the patient before
priming or purging.

Note: The call back alarm works only when the pump is powered on AND in the
STOP mode. DO NOT power-off the pump whileit is disconnected from the patient
if you have set the call back alarm.

When the alarm sounds, press [SILENCE] to silence the alarm for three minutes.
Then reconnect the pump to the patient.

'

Tip: To use a delayed start without specifying a start time:

Press[YES/ENTER].
Complete the program review.
Power-off the pump.

When the pump is powered on again, complete the program review, then
press [START] to begin delivery.

A W DN P
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5. Intermittent

Intermittent Delivery Interruptions

64

Missed Start Time

*

If the programmed start time is missed, it can be changed through the Options
Menu. Refer to Next Dose in Chapter 10 Options Menu, on page 111.

If the pump remains in the STOP mode and the first dose is missed, press [START]
to begin delivery immediately and all remaining doses will be shifted.

If the pump is programmed with a delayed start time and is then powered off
before [START] is pressed, the pump will skip to the NEXT occurrence of the
programmed start time.

For example, the current time is 10:00 PM. The user sets the delayed start time for
10:30 PM and then powers off the pump. The user does not power on the pump
until 10:40 PM, which is 10 minutes AFTER the scheduled start time. The pump
does not begin delivery until 10:30 PM the FOLLOWING day.

Dose Interruptions

To understand how interruptions are resolved, compare the normal Intermittent
delivery diagram below for a 1-hour dose every four hours, to the interruption
diagrams shown in the examples:

*

12 1 2 3 4 &5 6 7 8 9 10 11 12

Dose Delivered - D

If an Intermittent dose is interrupted and the pump is placed in the RUN mode
during the on or off cycle of the current dose, the dose continues delivery from the
point where it was interrupted and all remaining doses are shifted.

For example, in the following diagram, an intermittent dose was started at 2:00.
The dose was interrupted during the current dose cycle and was started again
before the end of the current dose cycle.
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5. Intermittent

12 1 2 3 4 5 6 7 8 9 10 11 12

Dose Delivered -D Dose Interrupted -

+ If an Intermittent dose is interrupted and the pump is placed in the RUN mode
after the off cycle of the current dose, the next dose begins delivery. All remaining
doses are shifted if necessary.

For example, in the following diagram, an intermittent dose was started at 2:00. It
was interrupted during the current delivery cycle at 2:30, but was not started again
until after the current delivery cycle at 6:45:

12 1 2 3 4 &5 6 7 8 9 10 11 12

Dose Delivered - D Dose Interrupted -

+  When the dose is complete, the start time for the Next Dose displays. To change
the start time refer to Chapter 10 Options Menu, page 97.

+ Any missed Intermittent doses, except the first dose, are added to the end of the
delivery schedule.
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5. Intermittent

Changing an Intermittent Program

66

Can be changed at Can be changed if no Cannot be changed
any time doseis in progress

y prog after is pressed
» Dose parameters « Next dose starttime | » Currenttime
* KVOrate

+ Container size
» Air sensitivity
* Call back alarm

Note: You cannot change a program when the pump isin FULL or CONTAINER
Lock.

To change a program:

1
2

From the STOP mode, press [CHANGE] and select CHANGE PROGRAM.

As each message displays, make the desired changes or press [YES/ENTER] to
accept the current setting.

Review the program. Press @ to begin review.
Press [START] to begin delivery.
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5. Intermittent

Q Start time:
Specify AM or PM if not 24-hour clock.

GemStar®
Intermittent Programming Worksheet
GIVE:
Parameters Selections and/or Values to be Entered Programmable
Ranges
Therapy Intermittent N/A
Dose Amount
0.1 -9600 mL
Infusion Time
Per Dose
hrs:min 1 min - 24 hrs
Dose (Infusion time per
Frequency dose + 1 min) to 96 hrs
hrs:min
Number of
Doses Per
Container 1-999
KVO O No KVO Rate: 0.0
(Keep Vein
Open) O Yes KVO Rate: 0.1 -5.0 mL/hr
Container
Size 0.1 - 9999 mL
Air Sensitivity | d On Alarms at approx. 0.5 mL of air N/A
Q 2mL Alarms at approx. 2 mL of air
a off No alarm
Call Back a No
Alarm a Yes
1 min to time between
Alarm: hrs:min before start | doses
Start Time Q Start immediately after programming

12:00 AM - 11:59 PM or
00:00 - 23:59

*  The pump automatically calculates the minimum container size required to deliver the number of
programmed doses and KVO between doses. If KVO is desired before a delayed start, increase the
container size to include the desired KVO volume.
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Chapter 6
Continuous

Therapy Features and Specifications
This therapy allows programming of a continuous delivery.
+ Optional KVO (Keep Vein Open) can be set during programming.
¢ The rate can be titrated while the pump is infusing.

+ An optional secondary container can be “piggybacked” on the primary container
during regular delivery using a GemStar Piggyback Pump Set. Refer to
Piggybacking in this chapter for more information.

Tip: The Programming Worksheet at the end of this chapter lists the minimum
' and maximum values allowed for this protocol. Use copies of the programming
worksheet to record program values before programming the pump.
Continuous Programming Tips

The following table explains how to use the keypad during continuous programming:

Key ’ Function Key ’ Function
[0]-[9] Selects menu items and Scrolls through program
enters numeric values. @ @ review and help

messages. The up arrow
inserts a decimal pointin a
numeric value.

Accepts entries or Clears a numeric value
% continues when done CHANGE (resets to zero) during
viewing a display. programming.

Displays information Returns to a previous
HELP during programming and BACK-UP display, exits the Options
alarm conditions. Menu, and exits the
HELP mode.
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6. Continuous

Continuous Programming

1 Select CONTINUOUS from the Programming Menu.
Select the unit of measure and concentration as required.
Enter the rate.
Enter the VTBI (Volume to be Infused).

Enter the KVO rate, if desired.

KVO runs after the programmed VTBI until the total container is infused. If no
KVO is desired, press [YES/ENTER] while the value displayed is zero.

6 Enter the container size (VTBI + KVO).
VTBI is the default value on the CONTAINER display.

a b ODN

Note: If KVO is programmed, increase the container size to include the KVO
delivery.

'

To enter the total in mL when programming a concentration, press @ to move to
the mL line. Enter the mL size when wL flashes on the display.

7 Select the air sensitivity, if required.
8 Review the program. Press @ to begin review.
9 If using the PURGE key to prime the pump set, press [PURGE] now.

WARNING: ALWAYS disconnect the pump set from the patient before
priming or purging.
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6. Continuous

Rate Titration

To titrate the rate while the pump is infusing:
1 In the RUN mode, press the number key for the new rate. Press [YES/ENTER].

For example: if the current rate is 100 mL/hr, press [5] [0] [YES/ENTER] to change
the rate to 50 mL/hr.

Note: You have approximately five seconds after pressing a key to press another
numeric key, the decimal key, or [YESIENTER]. If no key is pressed within five
seconds, the rate does not change and the delivery continues as previously
programmed.

X

2 NewW RATE displays with the new value.

*  Press [YES/ENTER] within 10 seconds to accept the change and begin delivery
at the new rate.

*  Press [NO] to continue delivery at the previously programmed rate.

Piggybacking

Piggybacking with the GemStar Pump requires a GemStar Primary Piggyback Pump
Set with a proximal Y-site backcheck valve and a secondary piggyback set with an
extension hook. The secondary container must be higher than the primary
container. Refer to the instructions included with the piggyback pump set for more
information.

WARNING: When using the pump for secondary delivery (piggybacking),
ensure the fluids being infused are chemically and physically
compatible.

The piggyback rate and piggyback VTBI display until the secondary container has
been delivered. Then the primary infusion continues.

Note: The piggyback infusion amount is NOT added to the primary programmed
infusion amount.

'
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6. Continuous

Preparing for Secondary Delivery (Piggybacking)

1 Ensure a primary piggyback pump set with a
proximal Y-site backcheck valve is in place.

2 Use the extension hook from the secondary set
to suspend the primary container from the L. V.
pole.

3 Prepare the secondary set according to the
instructions included with the set.

4 Attach a needle or blunt cannula (if appropriate)
and prime the secondary set.

5 Suspend the secondary container from the I.V.
pole.

Note: When using a secondary container of
500 mL or greater, ensure the bottom of the
secondary container is at least 7 inches (17.8
cm) above the fluid level in the primary
container. Use additional extension hooks if
necessary.

'

6 Connect the secondary set to the proximal Y-site
(or proximal luer port).
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6. Continuous

Programming a Secondary Delivery (Piggybacking)

L' Note: To distinguish the piggyback delivery from the
<4 primary delivery, PIGGYBACK displays and the piggyback PIGGYBACK
VTBI counts down to completion. For example, a RATE 250.0 mL/hr
piggyback rate of 250 mL/hr with a remaining VTBI of VIBI 218.5 mL
218.5 mL will display as shown. )y

’ Tip: Prepare and set up containers BEFORE programming the pump for piggyback
delivery.

1 Press [CHANGE] and select PIGGYBACKING from the Change Menu.
2 Enter the dose amount for the secondary container.

3 Enter the infusion time for the secondary container.
a4

Open the slide clamp or CAIR® (roller) clamp on the tubing of the secondary
container.

5 Press [YES/ENTER] to begin piggyback delivery.

Note: Primary flow stops until the secondary VIBI is delivered; then primary flow

continues. Any remaining secondary fluid will be delivered at the primary rate. The
maximum piggyback rate is 300 mL/hr. For secondary rates above 300 mL/hr; flow
may occur from the primary container.

4

Changing a Piggyback Delivery
Press [CHANGE] and select PIGGYBACKING from the Change Menu.
Press [CHANGE] to reset the dose amount to zero.

Enter the new piggyback dose amount and press [YES/ENTER].

D ON =

Set the infusion time for the secondary container.

5 Press [YES/ENTER] to begin piggyback delivery.

L Y Note: You must know the amount that has already been delivered. When the piggyback
4 dose amount is changed, the pump begins a new VIBI countdown.
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6. Continuous

Canceling a Piggyback Delivery

1 Press [CHANGE] and select PIGGYBACKING from the Change Menu.
2 Press [CHANGE] to reset the dose amount to zero.

3 Press [YES/ENTER] to cancel piggyback delivery.

Changing a Continuous Program

Can be changed at any time Cannot be changed
» Delivery rate » Container size * Unit of measure

« VTBI « Air sensitivity » Concentration

*« KVOrate « Piggybacking

R

Note: You cannot change a program when the pump is in FULL or CONTAINER Lock.

To change a program:
1 From the STOP mode, press [CHANGE] and select CHANGE PROGRAM.

2 As each message displays, make the desired changes or press [YES/ENTER] to
accept the current setting.

3 Review the program. Press ® to begin review.

4 Press [START] to begin delivery.
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6. Continuous

GemStar®
Continuous Programming Worksheet
GIVE:
Parameter Selections and/or Values to be Programmable Ranges
Entered
Therapy Continuous N/A
Unit of Measure | Q@ Concentration: mg/mL | 0.1 - 1000 mg/mL
O Concentration: mcg/mL | 1-1000 mecg/mL
o mL
Rate 0.1 - 9999 mg/hr
1-999900 mcg/hr
0.1-1000 mL/hr
VTBI 0.1-99999 mg
(Volume To Be 1-9999000 mcg
Infused) 0.1-9999 mL
KVO Q No KVORate: 0.0
(Keep Vein
Open) O Yes KVO Rate: 0.1-5.0 mL/hr
Container Size 0.1 -99999 mg
(VTBI + KVO) 1-9999000 mcg
0.1 -9999 mL
Air Sensitivity Q On Alarms at approx. 0.5 mL of air | N/A
Q 2 mL Alarms at approx. 2 mL of air
a Off Noalarm
Piggyback Dose
Amount 1-7200 mL
Piggyback 1 min or

Infusion Time

hrs:min

dose amount / 300 mL/hr to 24
hrs or dose amount/ 0.1 mL/hr
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Chapter 7

Weight Dosed

Therapy Features and Specifications
This therapy allows programming of delivery rate as a function of body weight.

+ The air sensitivity in a Weight Dosed program is automatically set to ON. This
setting can be changed through the Options Menu after programming is complete.
Refer to Air Sensitivity in Chapter 10 Options Menu, on page 107.

¢  The pump automatically delivers KVO (Keep Vein Open) after the programmed
VTBI (Volume To Be Infused) has completed.

¢ The rate can be titrated while the pump is infusing.
Tip: The Programming Worksheet at the end of this chapter lists the minimum and

maximum values allowed for this protocol. Use copies of the programming worksheet
to record program values before programming the pump.

WARNING: When using a vented drip set, ALWAYS use an air-
eliminating filter OR set the air sensitivity to either ON or

2 mL.

CAUTION: When infusing short-half-life drugs (i.e., those dosed with units of
mcg/kg/min) at very low rates (0.8 mL/hr or less) the rate may be too
slow for that drug. Consider using a lower drug concentration with
these drugs so a pump rate above 0.8 mL/hr can be used.
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7. Weight Dosed

Weight Dosed Programming Tips

The following table explains how to use the keypad during weight dosed programming;:

Key ‘ Function Key ‘ Function
[0]-[9] Selects menu items and Scrolls through program review and
enters numeric values. @ @ help messages. The up arrow inserts a

decimal point in a numeric value.

Accepts entries or Clears a numeric value (resets to zero)
continues when done CHANGE| | during programming.
viewing a display.

Displays information during Returns to a previous display, exits the
HELP| | programming and alarm BACK-UP| | Options Menu, exits the HELP mode.
conditions.

Welght Dosed Programming
Select WEIGHT DOSED from the Programming Menu.
2 Select the unit of measure.

L Y Note: If two numbers appear before a menu time (e.g., 02), press both number
) keys to select that item.

3 Enter the patient weight, if required.

4 Enter the concentration:
»  Enter the value for the unit of measure when it flashes on the display.
* Press [YES/ENTER] to confirm.

' Tip: Press @ to toggle between units of measure.

5 Enter the rate.

Note: The pump automatically displays the mL/hr equivalent even when another
unit of measure is selected.

6 Enter the VTBL
7 Review the program. Press (W) to begin review.

'
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7. Weight Dosed

8 If using the PURGE key to prime the pump set, press [PURGE] now.

WARNING: ALWAYS disconnect the pump set from the patient before
priming or purging.

Auto KVO

When the programmed VTBI has completed delivery, Auto KV O delivery begins
automatically and the empty container alarm sounds.

4

If the weight dosed rate is:

Note: Auto KVO delivers even while the empty container alarm sounds. Press
[SILENCE] to quiet the alarm for 2 minutes.

Auto KVO delivers at:

Greater than or equal to 1 mL/hr

1 mL/hr

Less than 1 mL/hr

The weight dosed rate

Rate Titration

To titrate the rate while the pump is infusing:
1 Inthe RUN mode, pressthe number keysfor the new rate. Press[YES/ENTER].
For example: if the current rate is 4.0 mg/kg/hr, press [5] [YES/ENTER] to change

therate to 5.0 mg/kg/hr.

Press (W) to enter the rate in mL/hr. When using units other than mL/hr, the pump
automatically adjusts the mL/hr value.

Note: You have approximately five seconds after pressing a key to press another

'\. numeric key, the decimal key, or [YES/ENTER]. If no key is pressed within five
seconds, the rate does not change and the delivery continues as previously
programmed.

2 NEW RATE displayswith the new value.
*  Press[YES/ENTER] within 10 seconds to accept the change and begin delivery
at the new rate.
* Press[NO] to continue delivery at the previously programmed rate.
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7. Weight Dosed

VTBI Titration
To titrate the VTBI while the pump is infusing:

1 Press [CHANGE] and select TITRATE VTBI.

2 Press the number keys for the new VTBI. Press [YES/ENTER].

For example: if the current VTBI is 50 mL, press [1][0][0][YES/ENTER] to change
the VTBI to 100 mL.

Note: You have approximately five seconds after pressing a key to press another
numeric key, the decimal key, or [YESIENTER]. If no key is pressed within five
seconds, the VTBI does not change and the delivery continues as previously
programmed.

4

3 NEW VTBI displays with the new rate.

*  Press [YES/ENTER] within 10 seconds to accept the change and begin delivery
with the new VTBL

e Press [NO] to continue delivery at the previously programmed VTBI.

Changing a Weight Dosed Program

Can be changed at any time Cannot be changed
» Delivery rate e Unit of measure
- VTBI » Concentration (amount of drug)

* Patient weight

'\4 Note: You cannot change a program when the pump is in FULL or CONTAINER Lock.

To change a program:
1 From the STOP mode, press [CHANGE] and select CHANGE PROGRAM.

2 As each message displays, make the desired changes or press [YES/ENTER] to
accept the current setting.

3 Review the program. Press @ to begin review.
4 Press [START] to begin delivery.
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7. Weight Dosed

GemStar® Weight Dosed Programming Worksheet

GIVE:
Parameter Selections and/or Values to be Entered Programmable
Ranges
Therapy Weight Dosed N/A
Unit of Measure** | O mcg/kg/min a mcg/hr N/A
a  mcg/kg/hr a grams/hr
Q mcg/min Q ng/kg/min
a  mg/kg/min Q  Ulkg/hr
a  mg/kg/hr a U/min
Q mg/min a Ulbr
Q ml/hr Q muU/min
a  mg/hr a mEg/hr
Patient Weight (When programming in kg/min or kg/hr)
2.0-200.0 kg
Concentration (For all units of measure EXCEPT mL/hr) 0.1 -9999000 mg
(2 entries are mg U mEq 0.1-99999999 U
required. Use (W in in in 0.1 - 9999 mEq
to toggle) mL mL mL 0.1-9999 mL
Rate
(see below *)
VTBI
(Volume To Be
Infused) 0.1-9999 mL
* Programmable Ranges for Rate (not all units of measure are available in all pump configurations):
0.001 - 833 mg/kg/min 0.1- 1000 mL/hr 0.001 - 99999999 U/min
0.001 - 500000 mg/kg/hr 0.001 - 999999 mg/hr 0.001 - 99999999 U/hr
0.001 - 16666 mg/min 0.001 - 9999999 mcg/hr 0.001 - 999999999 mU/min
0.001 - 166666 mcg/kg/min 0.001 - 999 grams/hr 0.001 - 999 mEg/hr
0.001 - 9999999 mcg/kg/hr 0.009 - 999 ng/kg/hr
0.002 - 166666 mcg/min 0.001 - 99999999 U/kg/hr

** |f two numbers appear before a menu item (e.g., 02), press both number keys to select that item.

CAUTION: When infusing short-half-life drugs (i.e., those dosed with units of mcg/kg/min) at very low
rates (0.8 mL/hr or less) therate may betoo slow for that drug. Consider using a lower drug
concentration so a pump rate above 0.8 mL/hr can be used.
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Chapter 8

mL/hr Only

Therapy Features and Specifications
This therapy allows quick programming of delivery rate in milliliters (mL) only.

+ The air sensitivity is automatically set to ON. This setting can be changed through
the Options Menu after programming is complete. Refer to Air Sensitivity in
Chapter 10 Options Menu, on page 107.

¢ The pump automatically delivers KVO (Keep Vein Open) after the programmed
VTBI (Volume To Be Infused) is complete.

¢ The rate can be titrated while the pump is infusing.

+ Anoptional secondary container can be “piggybacked” onto the primary container
during regular delivery using a GemStar Piggyback Pump Set. Refer to
Piggybacking in this chapter for more information.

¢ A program review is not required and is available only through the Options Menu.

Tip: The Programming Worksheet at the end of this chapter lists the minimum and
maximum values allowed for this protocol. Use copies of the programming worksheet
to record program values before programming the pump.

WARNING: When using a vented set, ALWAYS use an air-eliminating
filter OR set the air sensitivity to either ON or 2 mL.
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8. mL/hr Only

mL/hr Programming Tips

The following table explains how to use the keypad during mL/hr programming:

Key
[0] - [9]

‘ Function

Selects menu items and
enters numeric values.

Key

N2

‘ Function

Scrolls through program
review and help
messages. The up arrow
inserts a decimal point in
a numeric value.

Accepts entries or
continues when done
viewing a display.

CHANGE

Clears a numeric value
(resets to zero) during
programming.

HELP

Displays information
during programming and
alarm conditions.

BACK-UP

Returns to a previous
display, exits the Options
Menu, exits the HELP
mode.

mL/hr Only Programming

1 Select mL/hr only from the Programming Menu.

84

2 Enter therate.
3 Enterthe VTBI.
4 |If using the PURGE key to prime the pump set, press [PURGE] now.

WARNING: ALWAYS disconnect the pump set from the patient before
priming or purging.

Note: A programreview is not required for mL/hr Only programs.
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8. mL/hr Only

Auto KVO

When the programmed VTBI has completed delivery, Auto KVO delivery begins
automatically and the empty container alarm sounds.

L S Note: Auto KVO delivers even while the empty container alarm sounds. Press
) [SILENCE] to quiet the alarm for 2 minutes.
If the weight dosed rate is: ‘ Auto KVO delivers at:
Greater than or equal to 1 mL/hr 1 mL/hr
Less than 1 mL/hr The programmed rate

Rate Titration

To titrate the rate while the pump is infusing:
1 In the RUN mode, press the number keys for the new rate. Press [YES/ENTER].

For example, if the current rate is 100 mL/hr, press [5] [0] [YES/ENTER] to change
the rate to 50 mL/hr.

Note: You have approximately five seconds after pressing a key to press

4%

A another numeric key, the decimal key, or [YESIENTER/. If no key is
pressed within five seconds, the rate does not change and the delivery
continues as previously programmed.

2 NewW RATE displays with the new value.
*  Press [YES/ENTER] within 10 seconds to accept the change and begin delivery
at the new rate.
»  Press [NO] to continue delivery at the previously programmed rate.
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8. mL/hr Only

t

VTBI Titration
To titrate the VTBI while the pump is infusing:

1 Press [CHANGE] and select TITRATE VTBI.

2 Press the number keys for the new VTBI. Press [YES/ENTER].

For example: if the current VTBI is 50 mL, press [1][0][0][YES/ENTER] to change
the VTBI to 100 mL.

Note: You have approximately five seconds after pressing a key to press
another numeric key, the decimal key, or [YESIENTERY]. If no key is
pressed within five seconds, the VTBI does not change and the delivery
continues as previously programmed.

4

3 NEW VTBI displays with the new rate.

*  Press [YES/ENTER] within 10 seconds to accept the change and begin delivery
with the new VTBI.

*  Press [NO] to continue delivery at the previously programmed VTBI.

Piggybacking

Piggybacking with the GemStar Pump requires a GemStar Primary Piggyback Pump
Set with a proximal Y-site backcheck valve and a secondary piggyback set with an
extension hook. The secondary container must be higher than the primary
container. Refer to the instructions included with the piggyback pump set for more
information.

WARNING: When using the pump for secondary delivery
(piggybacking), ensure the fluids being infused are
chemically and physically compatible.

The piggyback rate and piggyback VTBI display until the secondary container has
been delivered. Then the primary infusion continues.

Note: The piggyback infusion amount is NOT added to the primary programmed
infusion amount.

4
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8. mL/hr Only

Preparing for Secondary Delivery (Piggybacking)

1 Ensure a primary piggyback pump set with a
proximal Y-site backcheck valve is in place.

2 Use the extension hook from the secondary set
to suspend the primary container from the L. V.
pole.

3 Prepare the secondary set according to the
instructions included with the set.

4 Attach a needle or blunt cannula (if appropriate)
and prime the secondary pump set.

5 Suspend the secondary container from the I.V.
pole.

Note: When using a secondary container of
500 mL or greater, ensure the bottom of the
secondary container is at least 7 inches (17.8
cm) above the fluid level in the primary
container. Use additional extension hooks if
necessary.

R

6 Connect the secondary set to the proximal Y-site
(or proximal luer port).
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8. mL/hr Only

'

X

'

88

Programming a Secondary Delivery (Piggybacking)

Note: To distinguish the piggyback delivery from the primary
delivery, PIGGYBACK displays and the piggyback VTBI
counts down to completion. For example, a piggyback rate

PIGGYBACK
RATE 250.0 mL/hr

of 250 mL/hr with a remaining VTBI of 218.5 mL will VIBL 218.5 mL
display as shown. ddid

Tip: Prepare and set up containers BEFORE programming the pump for piggyback
delivery.

1

a b ON

Press [CHANGE] and select PIGGYBACKING from the Change Menu.

Enter the dose amount for the secondary container.

Enter the infusion time for the secondary container.

Open the slide clamp or CAIR® (roller) clamp on the tubing of the secondary set.
Press [YES/ENTER] to begin piggyback delivery.

Note: Primary flow stops until the secondary VTBI is delivered; then primary flow
continues. Any remaining secondary fluid will be delivered at the primary rate. The
maximum piggyback rate is 300 mL/hr. For secondary rates above 300 mL/hr, flow
may occur from the primary container.

Changing a Piggyback Delivery

A ON =

5

Press [CHANGE] and select PIGGYBACKING from the Change Menu.
Press [CHANGE] to reset the dose amount to zero.

Enter the new piggyback dose amount and press [YES/ENTER].

Set the infusion time for the secondary container.

Press [YES/IENTER] to begin piggyback delivery.

Note: You must know the amount that has already been delivered. When the piggyback
dose amount is changed, the pump begins a new VIBI countdown.
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8. mL/hr Only

Canceling a Piggyback Delivery

1 Press [CHANGE] and select PIGGYBACKING from the Change Menu.
2 Press [CHANGE] to reset the dose amount to zero.

3 Press [YES/ENTER] to cancel piggyback delivery.

Changing a mL/hr Only Program

Can be changed at any time

* Delivery rate * Piggybacking
» Container size + VTBI

"4 Note: You cannot change a program when the pump is in FULL or CONTAINER Lock.

To change a program:
1 From the STOP mode, press [CHANGE] and select CHANGE PROGRAM.

2 As each message displays, make the desired changes or press [YES/ENTER] to
accept the current setting.

3 Press [START] to begin delivery.

L S Note: A program review is not required and is available only through the Change or
4

A

Options Menu.
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8. mL/hr Only
GemStar®
mL/hr Only Programming Worksheet
GIVE:
Parameter Selections and/or Values | Programmable Ranges
to be Entered
Therapy mL/hr Only N/A
Rate
0.1 - 1000 mL/hr
VTBI
(Volume To Be Infused) 0.1 -9999 mL
Piggyback Dose
Amount
1-7200 mL
Piggyback Infusion 1 min or
Time dose amount / 300 mL/hr to 24
hrs:min hrs or dose amount / 0.1 mL/hr
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Chapter 9
Variable Time

Therapy Features and Specifications

This therapy allows programming of multiple doses at specified times.

+ Optional KVO (Keep Vein Open) can be set during programming.
¢  The default bolus delivery rate is 400 mL/hr.

Tip: The Programming Worksheet at the end of this chapter lists the minimum and

maximum values allowed for this protocol. Use copies of the programming worksheet
to record program values before programming the pump.

Variable Time Programming Tips

The following table explains how to use the keypad during variable time

programming:
Key ‘ Function
[0]-[9] Selects menu items and

enters numeric values.

Key

I/

‘ Function

Scrolls through program
review and help
messages. Toggles
between AM and PM in
time-based entries. The up
arrow inserts a decimal
point in a numeric value.

Accepts entries or
continues when done
viewing a display.

CHANGE

Clears a numeric value
(resets to zero) during
programming.

Displays information
during programming and
alarm conditions.

BACK-UP

Returns to a previous
display, exits the Options
Menu, and exits the
HELP mode.
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9. Variable Time

Variable Time Programming
1 Select VARIABLE TIME from the Programming Menu.
Select the phase type.
Select the unit of delivery.
Change the displayed time if necessary.

Enter the optional base rate with start and stop time.

o a h ON

If programming in Rates or Doses, go to step 7. If programming in Percentages,
set the daily amount. Then go to step 8.

Note: If programming in percentages, the total daily amount of all phases pro-

%
A grammed must equal 100%.
7 Enter the phase information for each phase. Up to 24 phases can be programmed.
KN Note: When entering time in 12-hour format, press @ or @ to toggle
4 between AM and PM.
8 Enter the optional bolus dose and its lockout.
9 Enter the optional KVO.
10 Enter the container size.
The pump calculates the minimum container size required to deliver the phases,
base rate, and KVO for one day or in a 24-hour period. If delivering the protocol
for more than one day, multiply this amount by the number of days of
therapy.
a Note: Increase the container size to include bolus deliveries.
4

11 Select the air sensitivity, if required.
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9. Variable Time

12 Review the program. Press @ to begin review.
13 If using the PURGE key to prime the pump set, press [PURGE] how.

WARNING: ALWAYS disconnect the pump set from the patient before
priming or purging.

" Note: With variable time programming, the pump keeps track of whereit isin the

A program each minute of the entire 24-hour period. For example, if Phase 1 is missed,
and the pump is placed in RUN mode in the middle of Phase 2, it starts delivery
according to the program parameter s from the middle of Phase 2.

Variable Time Delivery Interruptions

If a phase is interrupted and the Then:

pump is placed in the RUN mode:

Before the end of the phase. The phase runs to its scheduled
stop time.

After the end of the phase, but before The next phase begins delivery at

the beginning of the next start time. the scheduled start time.

All applicable Base Rate or KVO
delivery infuses while waiting for the
start of the next phase.

In the middle of a phase and the phase | The pump immediately begins
start was missed because of a program | delivery of the current phase at its
interruption or a missed program start. current time-based point.
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9. Variable Time

Changing a Variable Time Program

Can be changed at Can ONLY be changed Cannot be changed
y
anytime before is pressed
* KVOrate e Current time e Unit of measure
« Container size » Base rate « Concentration
» Air sensitivity » Daily amount * Phase type
* Bolus » Phase parameters
'\ Note: You cannot change a program when the pumpisin FULL or CONTAINER Lock.
To change a program:
1 Fromthe STOP mode, press [CHANGE] and select CHANGE PROGRAM.
2 Aseach program parameter displays, make the desired changes or press
[YES/ENTER] to accept the current setting.
3 Review the program. Press ® to begin review.
4 Press[START] to begin delivery.
LY Note: The container size cannot be made smaller than the daily total of phases, base
4 rate, and KVO combined; or the current amount delivered, whichever is greater.
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9. Variable Time

GemStar® Variable Time Programming Worksheet

GIVE:
Parameter Selections and/or Values to be Entered Programmable
Ranges

Select Phase Type O Percentages 0.1-100%*
O Rates 0.1 -400 mL/hr
Q Doses 0.1-9600 mL

Unit of Measure a Concentration: mg/mL 0.1-1000 mg/mL
Q Concentration: mcg/mL 1-1000 mcg/mL
a mL

Current Time

Confirm or correct current time.

12:00 AM - 11:59 PM
or 00:00 - 23:59

Base Rate a No
Q Yes Start time: 12:00 AM - 11:59 PM
Stop time: or 00:00 - 23:59
Rate: 0.1 -400 mL/hr
Total Daily Amount for All Phases: (required only when programming in percentages)
- SEE ATTACHED WORKSHEET -

Bolus Dose

0.1 mL-25.0 mL
0.1 mg - 2500 mg
1 mcg - 25000 mcg

Bolus Lockout

minutes 5-999 min

KVO O No KVORate:0.0
(Keep Vein Open)

O Yes KVO Rate: 0.0 - 5.0 mL/hr
Container Size 0.1 -99999 mg
(Total Daily Amount X 1 - 9999000 mcg
Number of Days of
Therapy) 0.1-9999 mL
Air Sensitivity Q On Alarms at approx. 0.5 mL of air N/A

O 2mL Alarms at approx. 2 mL of air

a Off Noalarm

*Sum of all phases must equal 100% when programmed in percentages.
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9. Variable Time

Phase | Start Time Stop Time Percentage Rate Dose

O N| O O] B[ W N| =

1"
12
13
14
15
16
17
18
19
20
21
22
23
24

TOTAL | Note: The sum of all phases must equal 100%
when programmed in percentages.
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Chapter 10

Options Menu

Overview

1 REVIEW PROGRAM
1 Press [OPTIONS] from RUN or STOP mode. 5 HTSTORIES
2 Select the nqmber key for the desired function. 3 KEYPAD LOCK
3 Follqw the display messages for the sel@ct.ed o 4 PUMP SETTINGS
function. Refer to the appropriate description in this c SET CLOCK
chapter for more information.
6 PRINT
Note: Meny selections may vary depending on the . 7 SPEED PROTOCOL
configuration of the pump. For example, NEXT DOSE is
only available when an Intermittent therapy is 8 NEXT DOSE
programmed.
When the pump exits OPTIONS, the pump returns to the
mode it was in when [OPTIONS] was pressed.
Tips for Using the Options Menu
The following keys are helpful when using the Options Menu:
Keys ‘ Functions
[1]-[8] Press the corresponding number key to select a menu function.

display.

Press to accept changes or to continue when done viewing a

toggle AM and PM in time-based entries.

@ @ Press the up or down arrow to scroll through long display messages or to

BACK-UP Press to return to a previous display or to exit OPTIONS.

Tip: A menu item does not have to be on the display to be selected. For example, only
items 1 through 4 are shown when the Options Menu is first displayed. To select the

Print Menu without scrolling the display, press [6].
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10. Options Menu

Select this item
from the Options
Menu:

REVIEW
PROGRAM

To do this function:

Display the current program
settings.

Comments:

HISTORIES

Display the history for the latest
400 events, shift or volume totals,
bolus history (if available), or
current configuration settings.
Clear the history. Display the
Operation Test.

N/A

KEYPAD LOCK

Lock and unlock the keypad to
prevent unauthorized changes to
the program.

The lock levels allow the clinician
to restrict access to various levels
of pump operation.

PUMP SETTINGS

Change the air sensor, occlusion
sensor, and sound level settings.

N/A

SET CLOCK

Set the clock.

The clock can be displayed in
12-hour or 24-hour format.

PRINT

Print the history event log, bolus
history (if available), current
program settings, and speed
protocols.

Files may be downloaded to a
printer or personal computer.

SPEED
PROTOCOLS

Assign, review/recall, and delete
the stored protocols.

Allows up to 9 speed protocols to
be saved in pump memory.

NEXT DOSE

Change the start time of the next
dose when an interruption has
caused a missed dose in an
intermittent program.

NEXT DOSE appears on the
menu only when the pump isin an
intermittent program and
changing the next dose is
allowed.

98
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10. Options Menu

Review Program

1 Press [OPTIONS] and select REVIEW PROGRAM. The
pump displays PROGRAM REVIEW.

2 Press @ to begin review.

3 DPress [YES/ENTER] or [BACK-UP] when done to exit
OPTIONS.

1 REVIEW PROGRAM
2 HISTORIES

3 KEYPAD LOCK

4 PUMP SETTINGS
5 SET CLOCK

6 PRINT

7 SPEED PROTOCOL
8 NEXT DOSE

Histories T REVIEW PROGRAN
1 Press [OPTIONS] and select HISTORIES.

. ) 3 KEYPAD LOCK
2 Sclect the number key for the desired function. . PUMP SETTINGS
3 Complete the appropriate steps for the selected 5 SET CLOCK
function. 6 PRINT
7 SPEED PROTOCOL
8 NEXT DOSE
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10. Options Menu

Select this item To do this Display includes:

from the Histories function:
Menu:

HISTORY Display history Current date and time
event log of the « Date and time the program was cleared, a new
latest 400 events. container was selected, or a speed protocol was
recalled
» History event log of the latest 400 events
SHIFT TOTALS Display or clear » Time and date when shift was cleared
shift totals. + Volume infused in the shift
* Any relevant program-specific information
VOLUME TOTALS Display volume *  Amount infused
totals. . VTBI
* Any relevant program-specific information
CONFIGURATION | Display pump » Dependent upon pump configuration
configuration.
CLEAR HISTORY | Clear history event | « CLEARING HISTORY displays for 3 to 4
log and bolus seconds
history.
BOLUS HISTORY Display bolus * Current date and time
history in hourly +  Number of boluses delivered
increments for the | , Number of bolus demands
last 48 hours. « Amount delivered through bolus delivery
OPERATION TEST | Perform * Messages that guide the user through each
user-assisted section of the test
Operation Test.

2 Note: Some menu items may not be available depending on the configuration of the
\ pump.

' Tip: Press and HOLD @ or @ to scroll through the history displays faster.
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10. Options Menu

History
To display the history event log:
1 Press [OPTIONS] and select HISTORIES.
2 Select HISTORY from the Histories Menu.
3 Press @ or @ to scroll the display.
4 Press [BACK-UP] when done to exit OPTIONS.
Shift Totals
To display the shift totals:
1 Press [OPTIONS] and select
HISTORIES.
2 Sclect SHIFT TOTALS from the Histories Menu.
3  The shift totals display. Press @ or (W) to scroll

the display.

To clear the shift totals:

1
2

Follow the steps for displaying shift totals.
At the end of the shift totals, the pump displays
CLEAR TOTALS? YES OR NO:

e Press [YES/ENTER] to clear
the shift totals.

e Press [NO] to exit OPTIONS
without clearing the shift totals.

VERSION N.NNN
S/N XXXXXXXX
TIME IS 09:00 AM
FRI, JUN 11, 04

NEW CONTAINER
08:15AM JUN 11

HISTORY CLEARED
11:00PM JUN 10
EVENT LOG
PM11:18 SET ON
AIR SENSITIVITY
PM11:18 SET CONT
SIZE 100 mL
PM11:18 SET RATE
1.0 mL/hr
PM11:18 SHIFT
CLEARED
END OF EVENT LOG

Sample History Event Log

END OF
SHIFT TOTALS
CLEAR TOTALS?
YES OR NO a

' Tip: Press [HELP] to display shift totals when the pump is not in PROGRAMMING
mode or an alarm condition.

.
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10.

Options Menu

102

Volume Totals

To display the volume totals:

1 Press [OPTIONS] and select HISTORIES.

2 Select VOLUME TOTALS from the Histories Menu.
3 Press [BACK-UP] when done to exit OPTIONS.

To clear the volume totals:
) _ END OF
1 Follow the steps for displaying volume totals. VOLUME TOTALS

CLEAR TOTALS?

2 At the end of the volume totals, the pump displays
YES OR NO a

CLEAR TOTALS? YES OR NO:

*  Press [YES/ENTER] to clear
the volume totals.

e Press [NO] to exit OPTIONS
without clearing the volume totals.

Configuration

To display the pump configuration:

1 Press [OPTIONS] and select HISTORIES.

2 Select CONFIGURATION from the Histories Menu.
3 Press [BACK-UP] when done to exit OPTIONS.

Clear History

To clear the history event log and bolus history:

1 Press [OPTIONS] and select HISTORIES.

2 Seclect CLEAR HISTORY from the Histories Menu.

3 The pump display CLEARING HISTORY for 3—4 seconds before exiting
OPTIONS.

Tip: Press [BACK-UP] to exit OPTIONS immediately.
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10. Options Menu

Bolus History
To display the bolus history:
1 Press [OPTIONS] and select HISTORIES.

2 Select BOLUS HISTORY from the
Histories Menu.

TIME IS 09:15 AM
3 Press [BACK-UP] when done to exit OPTIONS. FRI, JUN 11, 04
BOL DEL 30
BOL DEM 37
BOL AMT 30.0 mL
06:10A TO 09:14A

Sample Bolus History
Note: Bolus History is only available if the current
program has a bolus programmed, or had a bolus
programmed at one time. The Bolus History is
maintained in hourly increments for the latest 48 hours.
The Bolus History is cleared when a new program is
entered, a Speed Protocol is recalled, or the History is
cleared.

4

Operation Test

The Operation Test checks several pump functions to ensure the GemStar Pump is
working properly. Refer to Chapter 14 Operation Test on page 143 for instructions.
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Keypad Lock REVIEW PROGRAM

1
1 Press [OPTIONS] and select KEYPAD LOCK from 2 HISTORIES
3

the Options Menu,

2 Select the desired lock level. 4 PUMP SETTINGS
5 SET CLOCK
) ) ) 6 PRINT
The following lock levels, listed from lowest to highest " SPEED PROTOCOL
restrictions, are available: 8 NEXT DOSE
Lock Level Abbreviation
Therapy Lock T
Rate Change R 1 THERAPY LOCK@
Lock 2 RATE CHANGE
Container Lock C 3 CONTAINER@
Full Lock F 4 FULL LOCK

The GemStar Pump allows two lock levels at the same time. Therapy Lock can be
used with either Full Lock, Container Lock, or Rate Change Lock.

When two lock levels are applied, if a function is available under one lock level but
not the other, the more stringent restrictions apply. The table on the following page
lists the functions available for each lock level.

When the pump is locked under a particular level, a small lock symbol (@) appears
next to the applied lock level as shown above. When the pump is in RUN or STOP
mode, the lock symbol appears in the lower left corner of the display and the lock
level abbreviation appears in the lower right corner.

la T |

Clinicians: refer to Chapter 11 Clinician Instructions on page 121 for detailed
instructions.
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10. Options Menu

GemStar® Keypad Lock Level Functions

U = Unlock
T = Therapy Lock
R = Rate Change Lock

C = Container Lock
F = Full Lock
* = Function is Available

Function T|R|C|F | Comments

Lock/Unlock Keypad e [+ | * |« | Rate Change Lock is available only if the
current program is Pain Management.

Power Pump On or Off LI B R

Start or Stop Infusion o | o |

Access Display, Help, Print, and o o | |

Program Review Functions

Deliver a Bolus e |* | | | If programmed.

Silence an Alarm LI O RO I

Select a New Container LI B

Purge o |o [

Change a Program o | Under Rate Change Lock, only the delivery
rate or bolus dose volume can be changed
and must be within the preset values.

Review/Recall Speed Protocol . Under Therapy Lock, the recalled protocol
must be the same type that was
programmed when the pump was locked.

Assign or Delete Speed Protocol .

Set Air Sensitivity, Distal .

Occlusion Level, Sound Level,

and Clock

Clear Shift Totals LI B

Program and Deliver a Loading
Dose (Outside of Programming
Mode)

Enter a New Program

Under Therapy Lock, the new program
must be of the same type that was
programmed when the pump was locked.

Piggybacking

VTBI Titration

Rate Titration

Operation Test

Clear History

Select Another Therapy
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Options Menu

Change Pump Settings

A

106

1 Press [OPTIONS] and select PUMP SETTINGS.

REVIEW PROGRAM
HISTORIES

1
2 Press the number key for the desired pump setting. 2
3 KEYPAD LOCK
4

3 Follow the display messages. Refer to the

instructions of the desired pump setting for more

information.

5 SET CLOCK

6 PRINT

7 SPEED PROTOCOL
8 NEXT DOSE

Select this item from To do this Comments:

the Pump Settings function:

Menu:

ATIR SENSOR Change the air The pump alarms when it detects an air
sensor sensitivity. bubble of approximately 0.5 mL when ON;

or at approximately 2 mL when 2 mL is
selected. The air alarm does not sound if
OFF is selected.

The air alarm can also be set during
programming if the current therapy allows
it.

OCCL SENSOR Change the distal Default Setting: High
occlusion sensor
sensitivity. The pump alarms when distal pressure is
greater than the selected occlusion
sensor limit.
SOUND LEVEL Adjust the audible Default Setting: Maximum
alarm level.

Note:The current setting flashes on the display.
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Air Sensitivity

WARNING: To reduce the risk of infusing air, use an air-eliminating
filter when the air sensitivity is set to OFF.

1 Press [OPTIONS] and select ATR SENSITIVITY. The current air sensitivity

flashes on the display.
2 Select the desired Air Sensitivity level.

Note:lf OFF is selected, the pump

ATIR SENSITIVITY

% , 1 ON
N, displays: 2 2wl
AIR ELIMINATING 3 OFF
FILTER IS RECOMMENDED.
ENTER TO CONFIRM
You must press [YESIENTER] to confirm. CHANGE AIR ALARM
3 After selecting the desired Air Sensitivity, the F?gp_/l : X};};};X
pump displays: CHANGE AIR ALARM FROM VES oR MO
XXXX TO XXXX:
*  Press [NO] to keep the current air sensitivity.
The current air alarm status displays and the pump exits OPTIONS.
*  Press [YES/ENTER] to accept the new setting. The new air alarm status displays
and the pump exits OPTIONS.
Occlusion Sensor
1 Press [OPTIONS] and select PUMP SETTINGS.
2 Select DISTAL OCCLUSION from
the Pump Settings Menu. DISTAL OCCLUSION
. . 1 HIGH
3 Select the desired setting. 5 MEDIUM
4 The pump displays MAKE XXXXX DEFAULT? 3 Low
*  Press [NO] to temporarily change the distal
occlusion setting. The new setting will be in effect
until a new program is entered or the pump has been off for more than 24
hours.
*  Press [YES/ENTER] to permanently change the distal occlusion setting. The
new setting will remain in effect until the setting is changed again through the
Options Menu.
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Sound Level
1 Press [OPTIONS] and select PUMP SETTINGS.

2 Select SOUND LEVEL from the Pump Settings Menu.

3 When the pump displays the Sound Level function, it

sounds intermittent beeps at the current sound level. - EENENEEE
The blocks on the top line of the display indicate the USE AW TO ADJUST
current sound level. THE SOUND LEVEL

ENTER WHEN DONE

* Press @ to increase the sound level.

e Press @ to decrease the sound level.

* Press [CHANGE] to restore the sound level to the default setting.
4 Press [YES/ENTER] when done.

Set Clock 1 REVIEW PROGRAM
1 Press [OPTIONS] and select SET CLOCK. 2 HISTORIES
2 Select 12-Hour or 24-Hour format (24-Hour format is > KEYPAD LOCK
shown in example). 4 PUMP SETTINGS

3 Use the arrow keys to set the weekday and month.

6 PRINT
4 Use the number keys to enter the current day, year, 7 SPEED PROTOCOL
and time. 8 NEXT DOSE

Note: When entering the time in 12-Hour format,
press @& or (W) to toggle between AM and PM.

4

SET CLOCK TYPE

5 Press [YES/ENTER] to confirm. 1 SELECT 12 HOUR
2 SELECT 24 HOUR

Tip: To view the clock from the RUN or STOP mode,
' press [YES/ENTER], then immediately press and HOLD
[1]. The clock displays until [1] is released. TIME IS 20:35

MON, JUL 26, 04

ENTER TO CONFIRM
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10. Options Menu

Print

WARNING: Ensure a cassette is installed in the pump before
connecting to a printer or computer.

If the pump is connected to a patient: BEFORE
connecting the pump to a computer or printer, press
[sTOP], close the slide clamp, and eject the cassette.
Leave the pump set connected to the patient. Install
another cassette in the pump before connecting to a
printer or computer.

" Note: Ensure the printer is connected to the pump BEFORE selecting a print
. function. Refer to Connecting to the Seiko Printer on page 115 for more

information.

1 Press [OPTIONS] and select PRINT.
2 Press the number key for the desired print function.

3 When printing is complete, the pump exits OPTIONS.

Select this item from
the Print Menu:

PRINT HISTORY

REVIEW PROGRAM
HISTORIES
KEYPAD LOCK
PUMP SETTINGS
SET CLOCK

7 SPEED PROTOCOL
8 NEXT DOSE

1
2
3
4
5
6

To do this function:

Print the current program, shift and volume totals, and history
event log.

PRINT PROGRAM

Print the current program.

PRINT PROTOCOL

Print a specified speed protocol or a complete list of all speed
protocols.

PRINT BOLUS Hx

Print the current program, shift and volume totals, and the
bolus history (Hx) for the latest 48 hours.

STOP PRINT Cancel printing. This function is only available if the pump is
printing.
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Speed Protocol 1 REVIEW PROGRAM

2 HISTORIE

1 Press [OPTIONS] and select SPEED PROTOCOL. STORLES
3 KEYPAD LOCK

2 Press the number key for the desired protocol 4 PUMP SETTINGS

function. 5  SET CLOCK

3 Follow the display messages. Refer to the 6 PRINT

7

instructions for Speed Protocol functions for more SPEED PROTOCOL
information. 8 NEXT DOSE

Select this item from To do this function:

the Speed Protocol Menu:

ASSIGN Store a program in pump memory for later use.

REVIEW/RECALL Review assigned protocols from the RUN or
STOP mode. Recall an assigned protocol from
the STOP mode.

DELETE Delete protocols from pump memory.

Assign
1 Press [OPTIONS] and select SPEED PROTOCOL.
2 Select AsSIGN from the Speed Protocol menu.

3 Select [1]-[9] to assign to the new protocol.

If the selected speed protocol is already assigned, the pump displays REPLACE
PROTOCOL ASSIGNMENT?

» Press [YES/ENTER] to replace the protocol. The pump displays the new speed
protocol and exits OPTIONS.

»  Press [NO] to keep the existing protocol and exit OPTIONS.
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Review/Recall
1 Press [OPTIONS] and select SPEED PROTOCOL.
2 Seclect REVIEW/RECALL from the Speed Protocol menu.
3 Select the desired protocol to review/recall.
4 Review the program. Press @ to begin review.
5 Press [YES/ENTER]:
* Ifin the STOP mode, press [1] to recall the protocol; or press [2] to review
another protocol.
e Ifin the RUN mode, the pump exits OPTIONS.
Delete
1 Press [OPTIONS] and select SPEED PROTOCOL.
2 Select DELETE from the Speed Protocol Menu.
3 Select the desired protocol to delete.
4 Press [YES/ENTER] to confirm deletion or [NO] to exit OPTIONS without deleting.
Next Dose 1 REVIEW PROGRAM
This function is only available when the current therapy is | 2 ~ HISTORIES
Intermittent and the pump is not delivering a dose. 3 KEYPAD LOCK
4 PUMP SETTINGS
To set the time for the next dose: 5 SET CLOCK
1 Press [OPTIONS] and select NEXT DOSE. 6 PRINT
2 7 SPEED PROTOCOL

Use the number keys to enter the start time for the
next dose. Press [YES/ENTER] to accept the change
and exit OPTIONS.

' Tip: When entering the time in 12-hour format, press @ or @ to toggle between
AM and PM.
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Connecting to the Data Port

112

Use the Data Port to connect the GemStar Pump to a Seiko® DPU 414 or compatible
seria printer to print the Operation Test results or the files available from the Print
Menu. Using communication software included with most computer operating
systems (or available from local sources), these files can also be transferred to a
computer.

WARNING: Ensure a cassette is installed in the pump before
connecting to a printer or computer.

If the pump is connected to a patient: BEFORE
connecting the pump to a computer or printer, press
[sTOP], close the slide clamp, and eject the cassette.
Leave the pump set connected to the patient. Install
another cassette in the pump before connecting to a
printer or computer.

Equipment Needed

‘ Connect to Printer ‘ Connect to Computer

GemStar Pump ° °

Hospira Serial Printer Cable List
13078-01

Seiko DPU 414 or Compatible
Serial Printer

Serial DB9 Female-to-Female
Gender Changer*

Null Modem* °

Computer* °

* Available from local sources.
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10. Options Menu

Configuration Settings

Refer to the printer or computer documentation for information on configuration
settings. Configure the printer or computer as follows to use the Data Port:

Baud Rate = 2400
Data Bits = 8
Stop Bits = 1
Parity = None
Carriage Return (+Line Feed) = CR+LF
Flow Control = None

Note: When using the Seiko DPU 414 printer, the switch settings MUST be configured
to work with the GemStar Pump.

R

To configure the switch settings on the Seiko DPU 414:
1 Press and hold the ONLINE button while sliding the POWER switch to ON.
2 When the list of the current settings start printing, release the ONLINE button.

3 Set the switches according to the following table.
Press the ONLINE button to continue setting switches.

¢ Press ONLINE to set switch ON.
¢ Press FEED to set switch OFF.

4 Continue setting switches until “Dip SW setting complete!!” is printed.
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10. Options Menu

Switch Settings for Seiko DPU-414 Printer

Switch | Function Setting | Button to Press
SW1-1 Input Method: Serial Off FEED
SW1-2 Printing Speed: High On ONLINE

SW1-3 | Auto Loading: On On ONLINE

SW1-4 | CR function: CRandLF | On ONLINE

SW1-5 | DIP SW setting Enabled On ONLINE

command:

SW1-6 | Printing density: 100% Off FEED
SW1-7 | Printing density: 100% On ONLINE

SW1-8 Printing density: 100% On ONLINE

SW2-1 Print Mode: 40 columns | On ONLINE

SW2-2 | User defined char: | On On ONLINE

SW2-3 | Ordinary On On ONLINE

Characters:

SW2-4 | Zero Font: No slash On ONLINE

SW2-5 | Character Set: American On ONLINE

SW2-6 | Character Set: American On ONLINE

SW2-7 | Character Set: American On ONLINE

SW2-8 | Character Set: American Off FEED
SW3-1 Data bit length: 8 bits On ONLINE

SW3-2 | Parity: No parity On ONLINE

SW3-3 | Parity condition: Odd On ONLINE

SW3-4 | Flow control: H/S busy On ONLINE

SW3-5 | Baud rate: 2400 bps On ONLINE

SW3-6 | Baud rate: 2400 bps Off FEED
SW3-7 | Baud rate: 2400 bps Off FEED
SW3-8 | Baud rate: 2400 bps On ONLINE

114 Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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10. Options Menu

Connecting to the Seiko Printer

WARNING: Ensure a cassette is installed in the pump before

connecting to a printer or computer.

If the pump is connected to a patient: BEFORE
connecting the pump to a computer or printer, press
[sTOP], close the slide clamp, and eject the cassette.
Leave the pump set connected to the patient. Install
another cassette in the pump before connecting to a
printer or computer.

CAUTION: Do not connect the GemStar AC Mains Adaptor to a printer.

Note: For maximum battery life, operate the pump on AC mains when connected to a
printer or computer.

1
2

3

Install a cassette into the pump.

Connect the GemStar serial cable to the printer and to the data port on the bottom
of the pump.

Ensure the printer is ONLINE and ready to receive data. Refer to printer
documentation for more information.

Ensure paper isloaded in the printer.
Select the desired print function from the pump menu.
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. Options Menu

N

116

Connecting to a Computer

WARNING: Ensure a cassette is installed in the pump before
connecting to a printer or computer.

If the pump is connected to a patient: BEFORE
connecting the pump to a computer or printer, press
[sTOP], close the slide clamp, and eject the cassette.
Leave the pump set connected to the patient. Install
another cassette in the pump before connecting to a
computer or printer.

Note: For maximum battery life, operate the pump on AC mains when connected to a
printer or computer.

Install a cassette into the pump.

Connect the GemStar serial cable to the null modem.

Connect the null modem to the serial gender changer.

Connect the serial gender changer to the serial port of the computer.

Connect the GemStar serial cable to the data port on the bottom of the pump.

O G A WON=

Configure the communication software on the computer. Refer to Configuration
Settings on page 113.

Tip: After the data transfer is complete, use any text editor to view or print the file.
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10. Options Menu

Transferring Data Using a Computer

The GemStar Pump can be connected to a Windows®-com<gatible com@guter. The
following instructions apply to computers using Microsoft~ Windows™ 95,
Windows® 98, or Windows NT® 4.0 or higher.
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Creating a New Connection

4

Note: The following procedureis only needed to create a“New Connection” the first
time the pump is connected to the computer.

To create a new connection:

1
2
3

N O 01 oA

8
9

16 Exit HyperTerminal.

118

.

Follow steps 14 in Using an Existing Connection on the following page.

If amessage appears asking if amodem is necessary for a connection, click NO.

Enter aname for the new connection (e.g., GemStar Print Files) and choose an

icon.
Click OK.

From the Connect drop-down menu, select the appropriate COM port.

Click OK.

Verify that the following settings are correct:

Baud Rate
DataBits
Stop Bits

Parity
Flow Control

Click OK.

2400
8
1
None
None

Select the Propertiesicon.

10 Select the Settings tab.

11 Select the ASCII setup button.

12 Ensure‘Append line feeds to incoming line ends’ is checked.
13 Click OK inthe ASCII setup window.

14 Click OK in the Properties window.

15 From the menu, select File > Save.
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10. Options Menu

Using an Existing Connection

To transfer data from the GemStar Pump to a computer:
1 From the Windows® desktop, select the Start Menu.

Select Programs.

Select Accessories.

Select HyperTerminal.

a b ODN

Double click on the icon with the name entered in step 3, Creating a New
Connection.

(<]

From the menu, select Call > Connect.

~J

From the menu, select Transfer > Capture Text.
8 Type the path and file name where the printout should be saved.
Ensure the file extension is “.txt”.

The default path is: c:\windows\accessories\hyperterminal.

Note: If the file name already exists, the new printout will be added to the end of
the existing file. For example, use a patient s name or id number as the file name.
Then select that file for all of that patient s printouts.

9 Click Start.

10 Select the desired print function from the pump. Refer to the table of printing
functions on page 109.

4

11 Wait for the transmission to complete.
12 From the menu, select Transfer > Capture Text > Stop.
13 Exit HyperTerminal.

14 Use any text editor to view or print the file.
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Chapter 11
Clinician Instructions

The instructions in this section apply to special features available to clinicians.
Remove this section from the manual to prevent unauthorized access to
these features.

The GemStar pump provides quick access to commonly used functions. Instead of
accessing these functions by navigating through the menu system, you can enter the
key combinations shown in this table:

Function ‘ Quick Access Key Combination

|

I

|

|

|

|

1

I

I

|

|

|

|

1

1

I

I

I

|

|

|

1

1

| Unlock Keypad Place the pump in STOP mode and then enter the lock
I sequence to unlock a Full Container or Rate Lock. You
| cannot use quick access keys to unlock a Therapy Lock.
|
|
|
1
1
|
I
|
|
|
|
1
1
|
I
I
|
|
1
1
I
|
I
|

Displays Shift Totals Place the pump in STOP mode and then press [HELP] to
display Shift Totals.
Display Clock Place the pump in STOP mode, press [YES], and then press
and hold [1]. The clock displays until you release [1].
Program a Loading From the Pain Management STOP MODE, press
Dose [YES/ENTER], and then press [0] to program a Loading
Dose.
1
1
1
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11. Clinician Instructions

Clinician Locking Sequence Instructions

Locking the Pump

To lock the pump from the RUN or STOP mode:

1
2

'

(<)

'

122

.

Press [OPTIONS] to display the Options Menu.
Select KEYPAD LocK from the Options Menu.

Note: If a lock level is already applied to the pump, the Lock Sequence Number
must be entered before a second lock level can be applied. Refer to Adding a
Second Lock Level on page 123 for more information.

Select the desired lock level. For THERAPY, CONTAINER and FULL Lock, go to
step 5.

For RATE CHANGE Lock, set the minimum and maximum programmable ranges
for the continuous delivery rate and bolus dose in a Pain Management program.

Tip: Press @ to toggle between the MIN and MAX values.

* MIN flashes on the display. Enter the minimum value.
» Max flashes on the display. Enter the maximum value.

Press [YES/IENTER] when done.
Repeat steps 4 and 5 for a bolus dose if available in the current program.

Enter the lock sequence number. Asterisks display as the numbers are entered.
e For THERAPY Lock, enter [0][0][0][3][1].

« For UNLOCKED, FULL, CONTAINER, and RATE CHANGE lock levels, enter
[1](3][0][o][0].

Note: Default lock sequence numbers are shown.
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11. Clinician Instructions

Adding a Second Lock Level

1

2
3
4

Press [OPTIONS] to display the Options Menu.
Select KEYPAD LOCK from the Options Menu.
Enter the Lock Sequence Number.

For RATE CHANGE Lock, set the minimum and maximum programmable ranges
for the continuous delivery rate and bolus dose in a Pain Management program.

Tip: Press @ to toggle between the MIN and MAX values.

* MIN flashes on the display. Enter the minimum value.
» MAX flashes on the display. Enter the maximum value.

Press [YES/ENTER] when done.

Repeat steps 4 and 5 for a bolus dose if available in the current program.

Note: When two lock levels are applied, if a function is available under one lock
level but not the other, the more stringent restrictions apply.

Enter the lock sequence number. Asterisks display as the numbers are entered.
*  For THERAPY Lock, enter [0][0][0][3][1].

¢ For UNLOCKED, FULL, CONTAINER, and RATE CHANGE lock levels, enter
[1][3][0][0][0].

Note: Default lock sequence numbers are shown.
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11. Clinician Instructions

Unlocking the Pump

1 Press [OPTIONS] to display the Options Menu.

2 Select KEYPAD LOCK from the Options Menu.

3 Select the lock level to be unlocked.

4 Enter the lock sequence number for that level.
Note: If the pump is locked under two levels, each level must be unlocked
separately. Unlocking one level has no effect on the other level. For example, if

both THERAPY and RATE CHANGE lock levels are applied, the clinician must
unlock both the RATE CHANGE and THERAPY locks.

5 The pump displays the current lock levels. Press [YES/ENTER] to return to the
mode the pump was in when [OPTIONS] was pressed.

Program and Deliver a Clinician Activated Loading Dose

124

This feature is available only when the keypad is UNLOCKED or when
THERAPY is the only lock level. The default loading dose rate is 125
mL/hr.

1 From the stop mode, press [YES/ENTER] [0].

2 The pump displays: PROGRAM A LOADING DOSE?
Press [YES/ENTER].

3 Enter the loading dose. Press [YES/ENTER].
4 The pump displays: DELIVER THE LOADING DOSE NOW?
To deliver the loading dose immediately, press [YES/ENTER].

Primary infusion DOES NOT begin automatically when the clinician activated
loading dose is complete. Press [START] to continue primary infusion.

To deliver the loading dose later, press [NO].

The pump returns to the stop mode. The next time [START] is pressed, the pump
again displays: DELIVER LOADING DOSE NOW?

*  Press [YES/ENTER] to deliver the loading dose. Primary infusion continues
automatically when the loading dose is complete.

*  Press [NO] to cancel the loading dose and continue primary infusion.
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11. Clinician Instructions

Shift Totals and History

Shift Totals
1 Press [OPTIONS] and select HISTORIES.

2 Select SHIFT TOTALS from the Histories Menu.

END OF
3 The shift totals display. Press SHIFT TOTALS
and (W) to scroll the display. When done, the CLEAR TOTALS?
pump displays CLEAR TOTALS? YES OR NO. YES OR NO a
*  Press [YES/ENTER] to clear the shift totals.

*  Press [NO] to exit OPTIONS without clearing
the shift totals.

' Tip: Press [HELP] to display shift totals when the pump is not in PROGRAMMING
mode or an alarm condition.

Clear History Event Log and Bolus History

1 Press [OPTIONS] and select HISTORIES.

2 Select CLEAR HISTORY.

3 CLEARING HISTORY displays and the pump exits OPTIONS.
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Chapter 12
Troubleshooting

This section contains information on audible and visual alarms that may occur with
the GemStar Pump.

CAUTION: If the pump doesnot perform asstated in thismanual, stop using it
IMMEDIATELY.

For consultation and technical support contact either an authorized Hospira
representative or the Hospira Technical Support Operations haotline (available 24
hours a day).

To return the pump for service, first contact Hospira Customer Support between 7:00
AM and 4:00 PM Pacific time. Have the pump serial number available.

In the USA Hospira Technical Support Operations
1-800-241-4002

Hospira, Inc.

Technical Support Operations
755 Jarvis Drive

Morgan Hill, CA 95037

Outside the USA: Contact your local Hospira sales
office.
’ Tip: Press [HELP] for additional information during programming and alarm conditions.
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12. Troubleshooting

Alarm Messages

Is the

pump
infusing?

Cause/
Condition

Alarm Display Alarm

Message

Remedy

Y = Yes A = Audible alarm

N = No V = Visual alarm

ATIR IN LINE

*  Pump automatically
enters STOP mode.

The specified volume
of air has been
detected in the line
distal to the cassette
while infusing.

1 Press [SILENCE] to quiet
the alarm for 1 minute.

2 Press [STOP] to clear the
alarm.

3 Disconnect the patient
from the pump set.

4 Press and hold [PURGE].
Note: Purge rate is 250

mL/hr. The pump purges for

up to 2 minutes each time
you press and hold
[PURGE]. Purge volume
may be limited in a Pain
Management program.

5 Reconnect the pump set to
the patient-access device.

6 Press [START] to begin
infusion.

CHANGE BATTERIES

ANV

The pump has
entered the STOP
mode due to battery
voltage below
acceptable levels.

1 Replace both disposable
batteries with fresh AA

batteries and press Qo to

restart the pump; OR
connect the pump to the

AC mains adaptor and the

pump will automatically
restart. Replace both
batteries as soon as
possible.

2  After power-on, resume the

current program. Refer to
Accessing the Programming
Menu in Chapter 2 Basic
Operation for more
information.

128
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12. Troubleshooting

Alarm Display Is the Alarm | Cause/ Remedy
Message pump Condition
infusing?
Y = Yes A = Audible alarm
N = No V = Visual alarm
CHECK CASSETTE-X |N A/ | The cassette is 1 Press [SILENCE] to quiet
improperly installed the alarm for 1 minute.
or not installed. 2 Press [STOP] to place the
X indicates where to pump in the STOP mode.
look for the cause of | 3  Reinstall the cassette.
the alarm: CAUTION: Ensure all
four cassette latches
A = Air Sensor are clearly visible after
) the cassette is
D = Distal installed.
_ . Note: Ensurethetubingis
P = Proximal behind the tubing guide (at the
distal end). Refer to Loading
the Cassette on page 32.
4  Press [START] to begin
infusion.
Note: The pump cannot be
powered off during a
CHECK CASSETTE alarm
(except during
PROGRAMMING mode).
CALL N A/ | The pump has 1  Write down the telephone

1.800.XXX.XXXX

CODE: NN/MMM/TTT

detected a condition
that may require
service.

number and code.

2 Power-off the pump. If the
pump does not power-off,
disconnect external power
and remove the batteries.

3 Call the telephone number
shown on the display

message.
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12. Troubleshooting

detected sustained
distal pressure over
the user-selected
limit.

To avoid a bolus
infusion after an
occlusion, complete
the following steps:

1 Press[STOP].

2  Close the distal
clamp.

3 Pressthe

cassette release
button to remove

Alarm Display Is the Alarm | Cause/ Remedy
Message pump Condition
infusing?
Y = Yes A = Audible alarm
N =No V = Visual alarm
DIST. OCCLUSION N A/ | The pump has Press [SILENCE] to quiet

the alarm for 1 minute.

Press [STOP] to place the

pump in the stop mode.

Check for sources of distal

occlusion:

» Kinked tubing below the
pump

» Clamped patient-
access device

» Clogged L. V. filter

» Other obstructions

If the problem continues,
remove and reinstall the
cassette.

CAUTION: Ensure all

the cassette from four cassette latches

the pump. are clearly visible after
4  Open the flow the cassette is

stop. installed.

5 Wait 10 seconds.,

6 Close the flow
stop.

7 Loadthe
cassette into the
pump.

8 Open the distal
clamp.

9 Review the
program.

10 Press [START]
to start the
pump.

Note: Ensure thetubing is
behind the tubing guide (at the
distal end). Refer to Loading
the Cassette on page 32.

Press [START] to begin
infusion.
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12. Troubleshooting

Alarm Display Is the Alarm | Cause/ Remedy
Message pump Condition
infusing?
Y = Yes A = Audible alarm
N = No V = Visual alarm
LOW BATTERIES Y A/ | The pump has Press [SILENCE] to quiet

detected battery
voltage below
acceptable levels and
the batteries are the
primary power
source.

Note: The pump
allows the user to
clear the LOW BAT-
TERIES alarm. If
the condition has not
been corrected after
15 minutes, the alarm
continues.

If the pump is infusing
anda LOW BAT-
TERIES alarm
occurs, the pump con-
tinues for approxi-
mately 30 minutes*
before it can no longer
deliver due to insuffi-
cient power.

*If an external power
source is used, the
rate is changed, or the
pump is powered-on
aftera LOW BAT-
TERIES alarm and
those same batteries
are still in the pump,
this interval may be

different.

the alarm for 15 minutes.

Press [STOP] to place the
pump in the STOP mode.

Connect the pump to AC
mains adaptor,
rechargeable battery pack,
OR replace both
disposable batteries with
fresh AA batteries.

Press [START] to begin
infusion.
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12. Troubleshooting

Alarm Display Is the Alarm | Cause/ Remedy
Message pump Condition
infusing?
Y = Yes A = Audible alarm
N =No V = Visual alarm
POWER LOSS N A/ | The pump has 1 Connect the pump to AC
detected a power mains adaptor,
failure due to one of rechargeable battery pack,
the following: OR replace both
_ disposable batteries with
. lEJBatterles havg fresh AA batteries.
een remove
while the pump 2 Pow_er-on the pump. _
was on battery Review the program if
source. required.
e External power 3 Press [START] to begin
has failed or has infusion.
been
disconnected and
no batteries are
installed.
e Pump has been
powered on with
insufficient power
source.
132 Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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12. Troubleshooting

Alarm Display Is the Alarm | Cause/ Remedy
Message pump Condition
infusing?
Y = Yes A = Audible alarm
N =No V = Visual alarm
PROX. OCCLUSION N A/ | The pump has 1 Press [SILENCE] to quiet

detected sustained
negative pressure on
its proximal side.

3 Check for sources of

4  Remove obstructions.
5 Press [START] to begin

6 If the problem continues,

the alarm for 1 minute.

2 Press [STOP] to place the
pump in the stop mode.

WARNING: When a
Proximal Occlusion alarm
activates, DO NOT
power-off the pump.

proximal occlusion:

» Kinked tubing above
pump

» Blockage in the

container and in the

spike

Closed clamps above

pump

Empty container

High torque syringe

»
»
»
» Other obstructions

infusion.

power-off the pump. Install
a new primed set and begin
infusion.

CAUTION: Ensure all
four cassette latches
are clearly visible after
the cassette is
installed.

Note: Ensure the tubing is
behind the tubing guides (at
the distal end). Refer to
Loading the Cassette on

page 32.
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Alarm Display Is the Alarm | Cause/ Remedy
Message pump Condition
infusing?
Y = Yes A = Audible alarm
N = No V = Visual alarm
USING BATTERIES Y \% This is a normal When powering on the pump:
response when:
* Press [YES/ENTER] to
« The pump has confirm disposable batteries
been powered on are the only power source.
with only
disposable When switching from AC mains
batteries as a .
. power:
power source; or
* The pump has * Press [SILENCE] to clear
switched to the alarm.
internal power
(disposable
batteries) due to a
loss of external
power or a
reduction in
external power
below acceptable
levels.
USING EXT BATT Y Vv This is a normal When powering on the pump:

response when:

* The pump has
been powered on
with external
batteries as a
power source; or

* The pump has
switched to
external battery
power due to a
loss of AC mains
power; or

* The pump has
switched to
external battery
power while
running on
internal batteries.

* Press [YES/ENTER] to
confirm external battery
power source.

When switching from AC mains
power:

* Press [SILENCE] to clear
the alarm.
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12. Troubleshooting

Alert Messages

Alert Display Message | Is the Alar | Cause/Condition Remedy
pump m
infusing?
Y = Yes A = Audible alarm
N =No V = Visual alarm
ALMOST EMPTY Y A/V | Delivery will complete in |+ Press [SILENCE] to
30 minutes or less. quiet the alarm for 10
minutes.
For bolus only program, Note: This alert is
delivery will complete available only with
during the next bolus Pain Management
delivery. protocols.
CHECK PRINTER Y A/V | The printer has not 1 Press [SILENCE] to

responded to
commands from the
pump.

* The printer is not
properly connected to
the pump.

quiet the alarm for 2
minutes.

2 Ensure the printer is
properly connected
to the pump by
checking the
following:

» Printer is powered
on and in ONLINE
mode.

» Cable is plugged
in to both the
pump and the
printer.

» Cable part
number and
printer settings
are correct.

3 If the problem
continues, select
STOP PRINT from
the Print Menu to

cancel all print jobs.
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e The pump delivers
KVO if selected.

the entire programmed
protocol.

Alert Display Message | Is the Alar | Cause/Condition Remedy
pump m
infusing?
Y = Yes A = Audible alarm
N =No V = Visual alarm
EMPTY CONTAINER N A/V | The pump has delivered |1  Press [SILENCE] to
the programmed quiet the alarm for 2
container size or the minutes.
pump has delivered the |5 press [STOP] to
programmed VTBI; AND place the pump in the
Auto KVO is delivering STOP mode and
(if available in current clear the alarm.
program). 3 Usethe NEW
CONTAINER
function to repeat the
current program.
Refer to Sarting a
New Container in
Chapter 2 Basic
Operation.
END OF INFUSION N A/V | The pump has delivered | If no KVO is selected:

1 Press [SILENCE] to
quiet the alarm for 2
minutes.

2 Press [STOP] to
place the pump in the
STOP mode and
clear the alarm.

If KVO is selected:

1 The pump sounds 5
beeps approximately
every 15 minutes.

2 Press [STOP]to
place the pump in
STOP mode and
clear the alarm.
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12. Troubleshooting

e START flashes on
the display. Other
parts of the display
are not affected.

has occurred because the
programmed pump has
remained in the STOP
mode for more than three
minutes.

Alert Display Message | Is the Alar | Cause/Condition Remedy
pump m
infusing?
Y = Yes A = Audible alarm
N =No V = Visual alarm
FLASHING DISPLAY N A/V | A Non-programming Follow the instructions on
) Callback has occurred the display to clear the
* Line four of the because the pump has | alarm.
display flashes. been waiting for more
than three minutes for a
keypress on a non-
programming input or a
confirmation display.
NO INTERNAL BATT N A/V | No disposable batteries |1  Press [YES/ENTER]
NO POWER LOSS or dead disposable to confirm.
ALARM AVAILABLE batteries; AND external
ENTER TO CONFIRM power. 2 Power-off the pump
and install two fresh,
disposable AA
batteries as a backup
power source.
PROGRAMMING N A/V | Programming has not 1 Press any key to
INCOMPLETE been completed and no clear the alarm.
keys have been pressed | o Complete the
within three minutes. program entries.
START N A/V | A Stop Mode Callback 1 Press [SILENCE] to

quiet the alarm for 3
minutes.

2  Follow the
instructions on the
display to clear the
alarm.

Hospira GemStar Manual 430-00897-002 (Rev. 10/04)

ﬁ%

%

137




g%% 430-00897-002.book Page 138 Friday, October 22, 2004 2:38 PM

12. Troubleshooting

Other Display Messages

Other Display Cause/Condition Remedy
Message
KEYPAD LOCKED User has attempted to Unlock the keypad to access the

perform a function that has desired function.
been locked out.

NOT ALLOWED User has attempted to * Press [STOP] to access the
DURING INFUSION perform a function that is desired function.
PRESS STOP TO not available in RUN mode. | . Press [YES/ENTER] to return to
HALT DELIVERY the RUN mode display.
ROUNDING The pump has rounded a Press [YES/ENTER] to accept the
number that was entered rounded value and continue to the
* The pump sounds | during programming. next step.

four quick beeps
and displays the
rounded number.

DOSE IN PROGRESS User has attempted to 1 Press [STOP].
NEW CONTAINER access NEW CONTAINER 2  Increase the container size to
NOT ALLOWED function when it is not complete the dose.
allowed.

3 Set NEW CONTAINER
through the Change Menu.

INFUSED XXXX.X mL | The pump has notdelivered Press [START] to infuse dose.

NO START DELAY any doses and there is no
PRESS START start delay.
TO INFUSE
CANNOT CHANGE User has attempted to 1 Press [STOP].
CLOCK WHILE TIME | change the clock during a 2 Clear the program through the
BASED DELIVERY time-based delivery. Change MpenS. g

IS IN PROGRESS
3  Change the clock through the
Options Menu.

4  Reprogram the pump.

PROGRAM EXCEEDS The VTBI + KVO volume 1  Press [HELP] to display the
MAX CONTAINER resulted in a container size allowed values.
SIZE. CHANGE reater than the allowed
PROGRAM VALUES . 8alue. 2  Change the program values.
THIS OPTION NOT User has attempted to 1 Press [YES/ENTER] to return to
AVAILABLE WHILE access a function that is not the first programming display.
PROGRA@’III;’IMIPI\TG THE available from the first 2 Complete programming.
programming display.

3 Access desired function.
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Chapter 13
Maintenance

Pump Storage

Store the GemStar Pump in a cool, dry place. Remove the disposable batteries and
the battery pack before storing the pump.

Program and event history are protected in the software memory for at least one year
when power is removed from the pump.

Cleaning and Disinfecting

Establish a routine schedule for cleaning the pump to keep the case exterior, cassette
pocket, and tubing channel free of contamination.

CAUTION: To avoid mechanical or electronic damage, do not immerse pump in
any fluids or cleaning solutions.

Some cleaning and sanitizing compounds may slowly degrade
components made from some plastic materials. Do not use
compounds containing combinations of isopropyl alcohol and
dimethyl benzyl ammonium chloride.

Do not sterilize by heat, steam, ETO, or radiation. Apply
disinfectants to the outside surface of the pump only. Do not use
abrasive cleaners or materials on the pump. Using abrasive
cleaners or cleaning solutions not recommended by Hospira may
result in product damage.

To avoid pump damage, cleaning solutions should be used only as
directed in the table on the following page. The disinfecting
properties of cleaning solutions vary; consult the manufacturer for
specific information.

Never use sharp objects (such as pens, pencils, fingernails, paper
clips, needles, etc.) to clean the pump.
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13. Maintenance

Recommended Cleaning Solutions

The pump is not adversely affected by the recommended cleaning solutions in the
table below:

Cleaning Solution

Manufacturer ‘ Preparation

Super Edisonite® S. M. Edison Per manufacturer’s recommendation
Chemical Co.

Vesphene Il se® Calgon Vestal Per manufacturer’s recommendation
Laboratories

Manu-Klenz® Calgon Vestal Per manufacturer’s recommendation
Laboratories

Formula C™ Diversey Corp. | Per manufacturer’s recommendation

Household bleach Various Per healthcare facility procedures;

) DO NOT exceed one part bleach in
(5.25% sodium ten parts water
hypochlorite)

Note: NOT all cleaning solutions are disinfectants. Check product labeling.

Cleaning the Pump Case

1
2
3

140

Power-off the pump.
Disconnect the pump from AC mains power.

Clean the exposed surfaces of the pump with a soft, lint-free cloth dampened with
the appropriate cleaning solution.

Wipe the solution from the pump surface with a water-moistened, lint-free cloth.

Use a dry, lint-free cloth to dry the pump after cleaning.
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13. Maintenance

Cleaning the Cassette Pocket and Tubing Channel

The area containing the ultrasonic sensors, located in the cassette pocket, should be
cleaned on a regular basis.

CAUTION: Use care not to damage the silicone seals around the sensor bodies.

1 Remove the cassette, if installed.

2 Use a cotton swab, moistened with an

approved cleaning solution, to clean the
sensor faces (A), tubing channel (B),
plunger tip (C), and sensor pins (D).

Dry the sensor faces and tubing channel
and ensure the sensor faces are free of
detergent film and/or debris.

Repair

*

The GemStar Pump has no user-serviceable components, with the exception of
disposable batteries.

If the display clock stops working, contact Hospira Technical Support Operations
to arrange for internal lithium battery replacement.

Homecare Customers: Call your healthcare professional or homecare company
regarding any required service or repairs. DO NOT attempt to repair the pump for
any reason.

The GemStar Pump is covered by a manufacturer’s warranty for one year after
purchase. During this time, opening the pump case for any reason voids this
warranty. Refer to Chapter 18 Warranty/Technical Assistance, page 189 for
details.

Refer all service to Hospira certified technicians only. A GemStar Technical Field
Service Manual is available to Hospira certified technicians.
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Chapter 14
Operation Test

This test is designed to ensure the GemStar Pump is operating properly. Hospira
recommends performing this test a minimum of once every 12 months. Refer to
facility requirements to determine additional testing needs.

The test can be performed when the pump is in the STOP mode and requires
approximately 15 minutes to complete. The pump provides step-by-step instructions
through each section of the test.

Note: This test is available only when the pump is UNLOCKED.

WARNING: Disconnect the pump from the patient BEFORE
performing the Operation Test.

Equipment Required

*

.

*

GemStar Pump

Two GemStar Microbore Pump Sets without a filter
Reservoir with at least 50 mL of water

20+ mL or larger graduated cylinder (graduated in 0.1 mL)
Two fresh, disposable AA batteries

Appropriate GemStar AC Mains Adaptor or other Hospira approved external
power source
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14. Operation Test

Test Setup

L Y Note: The pump clears any program and shift totals stored in pump memory before
) starting the Operation Test.

Connect the external power source and install two fresh, disposable AA batteries.

Power-on the pump.
Press [OPTIONS].

Select HISTORIES from the Options Menu.

A h ON=

Select OPERATION TEST from the Histories Menu.

6 Follow the instructions on the display.
Performing the Operation Test

' Tip: The checklist at the end of this section may be copied to record test results.

Case Inspection

1 Visually inspect the case and keypad for damage. Check the case for missing
screws, or labels.

2 Enter the results:

» Ifthe pump is free of damage and all the screws and labels are in place, press

[YES/ENTER].
» If damage is found on the case or keypad, or any screws or labels are missing,
press [NO].
144 Hospira GemStar Manual 430-00897-A02 (Rev. 02/05)

.

%

ﬁ

.



2
é‘g 430-00897-002.book Page 145 Friday, October 22, 2004 2:38 PM 4%

14. Operation Test

Cassette Pocket and Latch Inspection

1 Visually inspect the cassette pocket and the sensors (A). Verify that they are free
of dirt and residue.

N

Verify that the four cassette latches (B) are present. Verify that they open and
close when the cassette release button is pressed.

Verify that the plunger seal (C) and sensor seals (D) are present and intact.
Verify that the plunger (E) is not scraped or damaged.
Verify that the sensor pins (F) are not damaged.

Install the cassette. Verify the cassette fits smoothly and securely.

N OO a b~ o

Enter the results:

» If the cassette pocket area and latches are free of damage, and ALL of the
above steps are verified, press [YES/ENTER].

» If damage is found, or ANY of the above steps cannot be verified, press [NO].
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14. Operation Test

146

Power Check

Tip: Opening the battery compartment door will disconnect the batteries enough for
the pump to recognize external power. Then the door can be tightened and testing
can continue. This can save time when performing multiple tests on a group of
pumps.

1 The di%ay indicates that an external power source and batteries are connected.
Press .

2 Remove battery door and press @ The display indicates that only external
power is connected. Press @

3 Return the battery door to the closed position.

h

Disconnect the external power source and press @

5 The display indicates that only batteries are connected and displays the test
results. Press @

6 If the pump fails, reconnect the external power source and press @ to rerun the
test, or press [YES/ENTER] to confirm failure.

Keypad Test

1 Press each key, including the Bolus Button. Press [YES/ENTER] last.
2 Enter the results:

» If each key makes an audible tone, press [YES/IENTER].
* Ifany key does not make an audible tone, press [NO].

Display Test

1 Press [YES/ENTER] when prompted. The display fills with solid boxes for
approximately 10 seconds. To view the solid boxes for another 10 seconds after
the display times-out, press (A).

2 Enter the results:

» Ifthe display fills with solid boxes, press [YES/ENTER].
» If'the display does not fill with solid boxes, press [NO].
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14. Operation Test

LED Test

1 Verify that both the Power (green) and Alarm (red) LEDs are lit. Refer to the
GemStar Pump Layout in the “Introduction” section for the location of the LEDs.

2 Enter the results:
* Ifboth LEDs are lit, press [YES/ENTER].
o Ifeither of the LEDs does not light, press [NO].

Tip: Use two microbore pump sets to save time during the next four tests. The first
' set should be fully primed BEFORE beginning the volume accuracy test. Use a
second, DRY set for the air-in-line test.

When the proximal occlusion test is complete, remove the WET set from the pump
and insert the DRY set. Press [START] to begin the air-in-line test. The WET set can
then be placed in the next unit ready for testing.

Volume Accuracy Test

The pump should deliver between 19.0 to 21.0 mL within approximately 3 minutes to
pass this test.

1 Load a primed pump set into the pump. Press @ .

Place the proximal end in the reservoir of water. Press @ .

Place the distal end in a 20+ mL graduated cylinder. Press @
Press [START].

a b WON

Enter the results:
* If the pump delivers between 19.0 to 21.0 mL, press [YES/ENTER].
* If the pump does not deliver between 19.0 to 21.0 mL, press [NO].
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14. Operation Test

Distal Occlusion Test

The occlusion should occur within approximately 30 seconds to pass this test.

1 Clamp the pump set 10 to 12 inches (25.4 to 30.5 cm) below the cassette.
2 Press [START].
3 The test result displays. Release the clamp and press @
» If the test is passed, the pump advances to the next test.
o Ifthe test is failed, clean the sensors and press @ to rerun the test or press
[YES/ENTER] to confirm failure.

Note: Clean the sensor pins before repeating the distal occlusion test. Refer to
Chapter 13 Maintenance for instructions.

4

Proximal Occlusion Test

The occlusion should occur within approximately 30 seconds to pass this test.

1 Clamp the pump set above the cassette.
2 Press [START].

3 The test result displays. Press @
» If'the test is passed, the pump advances to the next test.

+ Ifthe test is failed, clean the sensors and press (&) to rerun the test or press
[YES/ENTER] to confirm failure.

LS Note: Clean the sensor pins before repeating the proximal occlusion test. Refer to
) Chapter 13 Maintenance for instructions.
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14. Operation Test

Air-in-line Test

The air-in-line alarm should occur within approximately 1 minute to pass this test.

Release the clamp.
Remove the proximal end of the pump set from the reservoir. Press @
Press [START].

The test result displays. Press @
» If the test is passed, the pump advances to the next test.

Hh ON =

o Ifthe test is failed, clean the sensors and press @ to rerun the test or press
[YES/ENTER] to confirm failure.

Note: Clean the sensor faces before repeating the air-in-line-test. Refer to Chapter 13
Maintenance for instructions.

Printing Test Results

When the test is complete, the pump displays an option to print the test results. If
desired, follow the steps below to print the test results. An example of the printed test
results is shown.

Note: For maximum battery life, operate the pump on AC mains power when con-
nected to a printer or computer.

1 Connect the serial printer cable to the pump. Refer to Connecting to the Seiko
Printer in Chapter 10 Options Menu, on page 115.

2 Press [YES/ENTER] to print the test results.

3 The pump displays the Programming Menu when the results have finished
transmitting or if [NO] is pressed.
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14. Operation Test

KAKKA AR IR AAAAA A AR AR AAA A AR A AR A AR A AR A AKX

* HOSPIRA GemStar *
* OPERATION TEST *
* RESULTS *

khkhkkhkhkhkhhkhhkhhkhhkhrhkrkhkrkhkrkhkhkhkhkkhkhkhkhhkhkhkhkxkhxkh*x*

PUMP SERIAL NUMBER: XXXXXXXXX

10:45AM JUL 4, 04
VERSION X.X.X

1. Case Inspection PASS
2. Cassette Pocket & Latch PASS
3. Power Check PASS
4. Keypad Test PASS
5. Display Test FAIL
6. LED Test PASS
7. Volume Accuracy Test PASS
8. Distal Occlusion Test PASS
9. Proximal Occlusion Test PASS
10. Air-in-Line Test PASS

R b I i Sh b b b b S I Sh Sh Ib b b S dh dh Sh Sb b b b db db Sh (Sb b b b db dh (dh 2b b b g 3
* VERIFIED BY: *
hkhkhkhk kA kA hhhrkhkrkhkhkhkhkhkhkhkhhkhhkhhkhkhkhhrhkrkhrkhxkx*k
kA kA kA kA kA kA hk A khk A khk Ak hA Ak hA kA hk A rk Ak hk A hAk A Ak A h kA khx %k

* END OF *
* OPERATION TEST *
* RESULTS *

kA hkkhkkhhkhkhhkhhkhkhAhhrhrhrkhkrkhkrkhkhkhkhhhhhkhhkxhxkh*x*k

1234567890123456789012345678901234567890
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14. Operation Test

GemStar®
Operation Test Checklist

Case Inspection

Cassette Pocket and Latch Inspection

Power Check

Keypad Check

Display Test

LED Test

Volume Accuracy Test

Distal Occlusion Test

Proximal Occlusion Test

Air-in-line Test

Printed Test Results

(I | I I I
(I | I I I

Serial Number:

Verified By: Date:
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Chapter 15
Optional System Components

All GemStar Optional System Components are composed of latex-free components

only.

Product Description ‘ List # ‘ Description

GemStar 13026-01 | Wall-mount adaptor plugs into a 110 VAC

AC Mains Adaptor mains supply to power the GemStar Pump.

(110 Volts - USA) 6 ft (1.8 m) cord.

GemStar 13072-01 | Tabletop adaptor plugs into a 100 — 240

AC Mains Adaptor VAC mains supply to power the GemStar

(100 — 240 Volts - Pump.

Universal)

GemStar 13027-01 | Allows bolus requests to be made up to 6

Bolus Cord feet (1.8 m) from the pump.

GemsStar 13076-01 | Attaches the GemStar Pump to an I.V.

Pole Clamp pole. The clamp is mounted to the track on
the back of the pump. Press the release
button to remove the pump.

GemStar Battery Pack 13073-01 | The rechargeable nickel metal hydride
batteries power the GemStar Pump during
periods of transport or when use of AC
power is not desirable. The battery pack is
recharged using a GemStar AC Mains
Adaptor.

GemStar Universal 12499-01 | Locks the GemStar Pump and up to a 250

Lockbox mL flexible 1.V. container or 30 mL PCA vial
in a plastic enclosure. The lockbox can be
attached to an I.V. pole using the GemStar
Pole Clamp (available separately).

GemStar 250 mL 13024-01 | Locks the GemStar Pump and up to a 250

Lockbox mL flexible I.V. container in a plastic
enclosure. The lockbox can be attached to
an L.V. pole using the GemStar Pole Clamp
(available separately).

Hospira GemStar Manual 430-00897-002 (Rev. 10/04)

ﬁ%

ﬁ%

153

ﬁ%



@E 430-00897-002.book Page 154 Friday, October 22, 2004 2:38 PM

4

15. Optional System Components

Product Description ‘ List # ‘ Description

GemsStar 30 mL PCA 13077-01 | Locks the GemStar Pump and a 30 mL
Vlal Lockbox PCA vial in a plastic enclosure. The
lockbox can be attached to an I.V. pole
using the GemStar Pole Clamp (available

separately).
Hospira Carrying 13594-01 | Soft-sided carrying case can be worn
Case - 250 mL around the waist to hold the GemStar
Pump and up to a 250 mL flexible
container.
Hospira Carrying 13079-01 | Soft-sided carrying case can be worn
Case - 500 mL around the waist or over the shoulder to

hold the GemStar Pump and up to a 500
mL flexible container.

Hospira Carrying 13980-01 | Soft-sided carrying case can be worn
Case - 1000 mL around the waist or over the shoulder to
hold the GemStar Pump and up to a 1000
mL flexible container.

Hospira Carrying 13593-01 | Soft-sided carrying case can be worn
Case - 3 Liter around the waist or as a backpack to hold a
3 liter or smaller flexible container and the
GemStar Pump with batteries or battery
pack. Includes List 13590-01.

Hospira 3 Liter Carrier 13590-01 | Interior support for the Hospira Carrying

Case - 3 Liter.
GemStar Docking 13075-01 | Plugs into a 100 — 240 VAC Volt mains
Station supply to power the GemStar Pump while
(100 — 240 Volts) mounted on an 1.V. pole. During periods of

transport, an internal rechargeable battery
pack powers the pump for up to 16 hours at
a rate of 125 mL/hr or less. When the AC
mains supply is attached, the internal
batteries are recharged in 4 to 6 hours. 12
ft. (3.6 m) cord.

GemStar 13078-01 | Connects the GemStar Pump to a
Serial Cable compatible serial printer or computer to
download the event history, program, or
speed protocol information.
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15. Optional System Components

Product Description ‘ List # ‘ Description

GemStar Connect 13048-01 | Allows remote access from a clinician’s

Clinician Kit computer to a GemStar Pump. The Kit
includes a modem, phone cable, serial
cable, and GemStar Connect software.

GemStar Connect 13049-01 | Use with the GemStar Connect Clinician

Patient Kit Kit to allow remote access to a GemStar
Pump. The Patient Kit includes a modem,
phone cable, and remote pump cable.

GemStar Triple Pole 13022-01 | Not for use with a lockbox.

Clamp

GemStar Technical 13000-38 | Provides advance instructions for Hospira

Field Service Manual Certified Technicians.

GemsStar Configuration | 13000-97 | Provides advance instructions for biomed

Guide technicians.

GemStar System 13981-01 | Provides operating instructions for patients

Operating Manual

and caregivers.
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15. Optional System Components

Connecting the Bolus Cord
(List 13027-01)
Connect the bolus cord to the port
labeled “Bolus” on the bottom of the
pump.

w

CAUTION:When removing the cord from the bottom of the pump, firmly grasp
the connector and pull straight out. DO NOT twist or bend the cord
or connector.

Using the GemStar Lockboxes

The GemStar Lockbox is an enclosure that can be locked with a key to secure the
pump, and a flexible container or vial. When the pump is secured in the lockbox, the
user has access to the AC mains connector, data and bolus ports, keypad, and bolus

button.
L Y Note: For the GemStar Universal Lockbox (List 12499-01) refer to the lockbox for
< instructions.
156 Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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15. Optional System Components

30 mL PCA Vial Lockbox (List 13077-01)

1
2

o O

Open the lockbox (A).
Flip the top door up (B).

Align the pump with the lockbox
(C).

Slide the pump down into the
lockbox until fully seated.

==

Flip the top door down.

Connect the pump set to the vial
and prime.

Place the vial inside the lockbox

(D).

d

Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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Load the cassette (E).

) EL

—

CAUTION: Ensure all four
cassette latches are clearly
visible after the cassette is
installed. Refer to Loading the
Cassette on page 32.

il
.

Note: Ensure the tubing is in the
tubing guide (at the distal end).

CASSETTE
LATCHES

CASSETTE
LATCHES

9 Ensure the tubing will not be

pinched when closing the lockbox.

10 Close and lock the lockbox.
11 Remove the key.
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15. Optional System Components

250 mL Lockbox (List 13024-01)

1 Open thelockbox (A).
2 Flip thetop door up (B).

3 Align the pump with the lockbox
(©).

4  Slide the pump down into the
lockbox until fully seated.

I OOOe
-

Flip the top door down.
6 Connect the pump set to the bag
and prime.

7 Placethe flexible container inside
the lockbox with the
administrative port down (D).

gl

.

4

8

9

Hang the bag on the hook inside
the lockbox (E).

Load the cassette (F).

]

CAUTION: Ensureall four
cassette latches are clearly
visible after the cassetteis
installed. Refer to Loading the
Cassette on page 32.

a D
CASSETTE CASSETTE
LATCHES LATCHES
- .‘

Note: Ensure the tubing isin the
tubing guide (at the distal end).

"

Bottom
Cap ———»

Tubing -
Guide

N

10 Ensure the tubing will not be

pinched when closing the lockbox.

11 Close and lock the lockbox.
12 Removethe key.
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15. Optional System Components

Removing the Lockbox

Remove the lockbox from the pole.

Unlock the lockbox.

Open the lockbox and flip the top door up.

Press the cassette release button to remove the cassette.
Lift the pump out of the lockbox.

A b ON=

Using the Hospira Carrying Cases

Ensure the administration set is fully primed and the cassette is properly loaded before
placing the pump in the carrying case. Refer to Chapter 2 Basic Operation for more

information.
Carrying Case - 250 mL (List 13594-01)

This soft-sided carrying case can be worn around the waist. It is designed to hold the
GemStar Pump and up to a 250 mL flexible fluid bag.

1 Place the fluid bag in the
zippered compartment (A) on
the backside of the case.
Ensure the bag spike is
positioned so that the fluid
flow is not restricted.

2 Place the pump inside the front
compartment (B) of the case.
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15. Optional System Components

3 Securethetubing to the inside
of the pack with the Velcro®
tabs (C). Ensure the tubing is
not kinked.

4 Usethelarge Velcro flap (D) on
the upper left side of the caseto
secure the tubing on the outside
of the case.

5 Closethe zipper. Ensure the
tubing exits the side of the case
near the zipper tab when the
Zipper isclosed (E).

6 Placethe case around the waist.
Snap the buckle together to
secure.

7 Adjust the belt for a snug,
comfortable fit.

Carrying Case - 500 mL (List 13079-01) or 1000 mL (List 13980-01)

These soft-sided carrying cases can be worn around the waist or over the shoulder.
They are designed to hold the GemStar Pump and up to a500 mL (List 13079-01) or a
1000 mL (List 13980-01) flexible fluid bag.
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15. Optional System Components

1 Placethe pump on theinside front
window (A). Ensure the keypad is
facing the “window.”

2 Securethe pump with the large side
straps (B) and (C). Then secure the
top (D) and bottom (E) straps.

3 Placethefluid bag on the backside
of the compartment (F).

4  Secure the bag with flaps (G) and
(H).

5 Securethe bag spike with strap (1).
Ensure the fluid flow is not
restricted.

6 Usea“figure-8" patternto wrap the
tubing. Secure the tubing to the
inside of the case with tabs (J) and
(). Ensure the tubing is not kinked.

7 Zip the case closed. Ensure the
tubing exits through one of the sides
near the zipper tab when the case is
closed.
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15. Optional System Components

8 Placethe case around the waist with the front “window” facing away from the

body. Snap the buckle together to secure. Adjust the belt for a snug, comfortable
fit.

Carrying Case - 3 Liter (List 13593-01)

This soft-sided carrying case can be worn around the waist or as a backpack. It is

designed to hold the GemStar Pump with batteries or abattery pack, and up to a3 liter
flexible fluid bag.

Note: This carrying case includes an interior support (Hospira 3 Liter Carrier List
< 13590-01) that may be removed from the case and used separately.

'
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15. Optional System Components

Unzip the carrying case and release all Velcro straps and flaps.

Place the fluid bag on the carrying case as shown (A).

Hook top strap (B) through the hole in the top of the fluid bag and secure.
Fold small flaps (C) and (D) over the bag as shown and secure.

A b ON=

Secure straps (E) and (F) across the length of the fluid bag and over the small
flaps.

(<)

Secure the spike connection with strap (G).

~

Fold large flaps (H) and (I) over as shown and secure.

Place the pump, with the keypad facing upward, inside the pocket (J) on the flap.
The pump’s display should be visible through the opening on the front of the
pocket.

9 Secure the pump with straps (K) and (L).

10 Secure the tubing with strap (M).

11 Place the secured pump (N) inside the large zipper case or other carrying case.
12 Zip the large case closed.

13 If desired, route the tubing through the loops on the bottom of the carrying case.
Ensure the tubing is not kinked.

14 Adjust the shoulder straps and waist belt for a snug, comfortable fit.

’ Tip: When not using the waist belt, secure it under the large flap on the back of
the case.
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15. Optional System Components

Using the GemStar Docking Station

(List 13075-01)

Connecting the Pump

1

2

3

a4

Mount the docking station to the I.V. pole and tighten the
knob.

Align the connectors on the bottom of the pump with the
connectors on the docking station.

Slide the pump into the docking station until it snaps into
place.

Connect the docking station to AC mains power.

LS Note: The docking station light is yellow while the docking station is charging. When
5 the docking station is fully charged, the light is green.
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15. Optional System Components

Connecting the Bolus Cord and Printer Cable

WARNING: Ensure a cassette is installed in the pump before
connecting to a printer or computer.

If the pump is connected to a patient: BEFORE
connecting the pump to a computer or printer, press
[sTOP], close the slide clamp, and eject the cassette.
Leave the pump set connected to the patient. Install
another cassette in the pump before connecting to a
printer or computer.

1 Plug the bolus cord into the bolus port on the rear, right
side of the docking station.

|
2 Plug the printer cable into the printer port on the rear,
right side of the docking station. @

Disconnecting the Pump

To remove the pump:

1 Press the release button on the top
of the docking station.

2 Slide the pump out.

.
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Chapter 16

Pump Sets

Hospira GemStar Manual 430-00897-002 (Rev. 10/04)

CAUTION: USE ONLY GemStar Pump Sets with the GemStar Pump. Use of
unauthorized sets may result in injury to the patient or damage to

the pump.
Contact a Hospira Representative for appropriate pump set configurations.

Fluid path and areas beneath undisturbed protective set covers are
sterile and nonpyrogenic in the intact unit package. STERILE] @

The GemStar Pump Sets, listed in the table on the following page
are available for use with the GemStar Pump.

Note: The disposable pump sets should be changed per the Centers for Disease
Control (CDC) guidelines or health care provider policy. Discard after use.
All GemStar Pump Sets are composed of latex-free components only.

GemStar Pump Sets contain an anti-siphon valve to reduce the potential for gravity
flow at a typical 36-inch head height.
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16. Pump Sets

The following sets are a representation of the GemStar® Pump Sets currently
available:

List No. ‘Description

Ambulatory Sets

13263 Latex-Free GemStar® Pump Set and Extension Set with integral
pressure-activated anti-siphon valve, Secure Lock, Nonvented, Microbore
tubing, 96 in (244 cm)

13264 Latex-Free, LifeShieId®, GemsStar® Pump Set with 0.2 Micron Filter, Secure
Lock, Prepierced reseal injection site, Nonvented, Pre-attached
pressure-activated anti-siphon valve, Microbore tubing, 96 in (244 cm)

13265 Latex-Free, LifeShield®, GemStar® Pump Set with 1.2 Micron filter, Secure lock,
Prepierced reseal injection site, Nonvented, Pre-attached pressure-activated
anti-siphon valve, NonPhthalate (Non-DEHP) microbore tubing, 96 in (244 cm)

13273 Latex-Free GemStar® Pump Set, Secure lock, Non vented, Pre-attached
pressure-activated anti-siphon valve, Microbore tubing, 96 in (244 cm)

General Infusion Sets

13244 Latex-Free, GemStar® HEMA® I, Y-Type Blood Set, 210 Micron Filter, Lower
CLAVE® Connector, Macrobore tubing, 110 in (279 cm)
13267 Latex-Free, LifeShield®, GemStar® Primary Piggyback Pump Set, Secure Lock,

Convertible, Macrobore Tubing Piercing Pin, 2 CLAVE® connectors,
Pre-attached pressure-activated anti-siphon valve, Macrobore tubing, 110 in

(279 cm)

13272 Latex-Free, LifeShield®, GemStar® 150 x 60 micro drip SoluSet® Option Lock,
Convertible Piercing Pin, 2 CLAVE® connectors, Macrobore tubing, 110 in
(279 cm)

13274 Latex-Free, LifeShield®, GemStar® Piggyback Pump Set, with 0.2 Micron Filter,

Secure Lock, Convertible Piercing Pin, 3 CLAVE® Connectors, Pre-attached
pressure-activated anti-siphon valve, Macrobore tubing, 110 in (279 cm)
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16. Pump Sets

List No. ‘ Description

Pain Management Sets

13045 Latex—Free, GemStar® Pump Set, Integral pressure-activated anti-siphon valve
Secure Lock, Nonvented with PCA injector and female Luer Lock™ adapter,
Microbore tubing, 96 in (244 cm)

13047 Latex—Free, GemStar® Pump Set with PCA Extension, Integral
pressure-activated anti-siphon valve, Secure Lock, Nonvented with PCA
injector and female Luer Lock ™ adapter, Microbore tubing, 96 in (244 cm)

13261 Latex-Free, GemStar® Pump Set and Extension Set with integral
pressure-activated anti-siphon valve, Secure Lock, Non-vented, Microbore
tubing, 110 in (279 cm), Yellow Striped Tubing
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Chapter 17

GemStar Pump Specifications

Physical

Dimensions:

Weight:

The GemStar Pump is composed of latex-free components
only.
Height: 5.5 in. (14.0 cm)

Width: 3.8 in. (9.7 cm)

Depth: 2.0 in. (5.1 cm)
Approximately 17 oz. (482 grams) excluding batteries

Transport and Storage
Environment
Ambient Temperatures:
Relative Humidity:
Atmospheric Pressure:

Store in cool and dry environment.

-4° F to +140° F (-20° C to +60° C)
10% to 90%
0-10,000 ft. (0-3,000 m) equivalent pressure

Operating Environment

Ambient Temperatures:

+41° F to +104° F (+5° C to +40° C)

Power Sources
AC Mains:

List 13026-01
(USA) complies with UL 544

List 13072-01
(Universal) complies with CSA 22.2
No. 601.1 and UL 60601-1

Battery:

Battery Pack:
Docking Station:

Wall-mount AC mains adaptor; 6 ft. (1.8 m) cord molded plug
Input: 110 VAC
Output: 3.0 VDC

Tabletop AC mains adaptor; molded plug
Input: 100-240 VAC
Output: 3.0 VDC

Two disposable AA alkaline or lithium batteries

Rechargeable using GemStar AC Mains Adaptor
Mounts on an L.V. pole; 12 ft. (3.6 m) cord

Input: 100-240 VAC

Output: 3.0 VDC

Internal rechargeable battery
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17. GemStar Pump Specifications

Using two fresh, disposable AA batteries or a charged battery
pack, at temperatures between 59° F and 95° F (15° C and
35° C), the pump is capable of delivering approximately:

Power Capacity

96 hours at rates below 5 mL/hr

48 hours at rates at or above 5 mL/hr but below 25 mL/hr
24 hours at rates at or above 25 mL/hr but below 125 mL/hr
3000 mL at a rate of 125 mL/hr or higher

Volumetric, Piston Driven

Pump Mechanism

Current program and 400-event (history) log protected by
internal lithium battery-backed memory for at least one year
after power is removed

One 23-key keypad; bolus, data port, and AC mains jacks;
bolus button

External Power LED Green LED marked with plug icon lights continuously when
pump is connected to AC mains power

Green LED flashes when pump is connected to external

Memory Protection

Operating Controls

batteries

Alarm LED Red LED marked with alarm icon lights during alarm
conditions

Audible Alarm The audible alarm is user-adjustable from the maximum

volume down to silent

The alarm automatically reverts to the maximum volume if the
user does not respond within one minute
Backlit, four-line-by-sixteen-character alphanumeric graphics
display

Backlight on AC: | Continuous
Backlight on Batteries: | Continuous during programming, program review, and history
display; otherwise activated by keypress or alarm; not
activated by bolus request
Real Time Clock Accuracy of £5 minutes per month or better at temperatures
between 59° F and 95° F (15° C and 35° C)

Display

Print Function
Port & Interface: | RS-232 serial interface port (data port), minimum baud rate of

2400, isolated circuit

Printers: | Seiko DPU 414 or compatible serial printer

+ 10% for rates of 0.1 mL to less than 5 mL/hr

System Accuracy
+ 5% for rates of 5 mL to 1000 mL/hr
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17. GemStar Pump Specifications

Air Sensitivity
ON:| Pump alarms at approximately 0.5 mL of air

Alarms for any bubble greater than 500 microliters with
a tolerance of 200 microliters

2 mL: | Pump alarms at approximately 2 mL of air

Alarms when pump detects 2.0 +1.0/-0.2 mL of air in 6
mL of total volume delivered

OFF: | Alarm is not activated

Recommend using air-eliminating filter when Air
Sensitivity is set to OFF

Occlusion Sensitivity
Distal Occlusion: | Alarms when pump detects distal pressure within a selectable

range:

Low: 7 psi (48 kPa) £ 5 psi (+34 kPa)

Medium: 12 psi (83 kPa) +8 psi (+55 kPa)

High: 26 psi (179 kPa) £14 psi (96 kPa)
Proximal Occlusion: | Alarms when pump detects proximal pressure less than or
equal to -4 psi (-28 kPa)

Piggyback Rate 0.1 to 300 mL per hour

Pump Self-Tests and Safety Self-test performed when the power switch is activated

F

eatures Diagnostic routine, including motor speed and air-detection
monitoring, is repeated continuously while the pump is
powered on
Error and alarm conditions are indicated by both audible and
visual alarms; delivery in progress is stopped, if appropriate
(refer to Chapter 12 Troubleshooting)
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17. GemStar Pump Specifications

Occlusion Information

174

Avoiding Bolus Infusion After Occlusion

1
2

Press [STOP].

Close the distal slide clamp or CAIR® (roller)
clamp.

Press the cassette release button to eject the
cassette from the pump.

Press down on to open the flow stop.
Wait 10 seconds.

Press down on to close the flow stop.
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17. GemStar Pump Specifications

7 Load the cassette.

CAUTION: Ensure all four cassette latches
are clearly visible after the
cassette is installed. Refer to
Loading the Cassette on page 32.

Note: Ensure the tubing is behind the
tubing guide (at the distal end).

'

8 Open the distal slide clamp or CAIR®
(roller) clamp.

9 Review the program. Press ) to begin
review.

10 Press [START] to start the pump.

Hospira GemStar Manual 430-00897-002 (Rev. 10/04)
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17. GemStar Pump Specifications

Stored Occlusion Volume

Delivery Rate of 25 Pressure Limit Stored Volume Time to
mL/hr at in mL Occlude
in seconds
Pressure Setting: Macro Micro | Macro Micro
Low 7 psig 7 psig 0.26 0.09 50 15
(48.3 kPa) (48.3 kPa)
Medium 14 psig 13 psig 0.54 0.14 96 23
(96.5 kPa) (89.6 kPa)
High 32 psig 30 psig 1.24 0.40 254 83
(220.6 (206.8
kPa) kPa)

Delivery Rate Accuracy

The following trumpet curves represent the typical flow rate deviations, both positive
and negative, from the programmed flow rate under test conditions defined by
International Electrotechnical Commission (IEC) Standards for infusion pumps.
Using these curves, the medical professional may determine if the device can be
expected to perform in a manner suitable for the drug or fluid to be infused. The pump
sets used in this test are comparable to GemStar Pump Set List 13273.

The typical accuracy for this device is + 5% of the programmed rate for most
conditions, after a period of normalization. It is recommended that the medical
professional refer to the following curves when making decisions regarding drug and
fluid administration.

A single fault condition occurs when a single means for protection against a safety
hazard in equipment is defective or a single external abnormal condition is present.

The maximum over-infusion volume from a single fault condition is based upon the
calculation of the maximum time to generate an alarm times the maximum rate
possible (1000 mL/hr) as a consequence of the fault. This has been determined not to
exceed 2.78 mL.

CAUTION: When using pre-filled vials, the system may underdeliver at low
flow rates.

Note: False occlusion alarms and fluid delivery inconsistencies may occur when
pumping viscous fluids in microbore tubing at rates greater than 500 mL/hr.
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17. GemStar Pump Specifications

Trumpet Curves

The Trumpet Curve Graphs following the Example show representative maximum
and minimum percent flow rate deviation from the programmed rate over time. This
information was developed in accordance with IEC 60601-2-24: 1998, Sub-Clause
50.102. Refer to this standard for detailed information.

How to read a Trumpet Curve Graph (Refer to example on the following page):

The graphs following the Example plot flow rates at 30 second intervals for the first 2
hours and for the 96th hour of delivery. The graph plots mean delivery rate error
(Average of 3 pumps) for the 2nd hour and the 96th hour as a straight line. The graph
also presents maximum and minimum average delivery rate error for this interval
plotted by averaging delivery errors over intervals of 2, 5, 11, 19 and 31 minutes
(“Trumpet Curve”).

Example

From the Trumpet Curve Graph sample that follows, find the 5 minute interval (A) at
the horizontal axis and read the corresponding points (B) and (C) on the vertical axis.
The values are approximately +2.8% and -0.5%.

This means that at the rate of 25 mL/hr the average maximum flow rate fluctuation for
any 5 minute time interval during the 2nd hour of operation was within the limits of
+2.8% and -0.5% from the nominal rate. The average delivery rate error over the
entire 2nd hour was +1.6% (D).

For other time intervals look at other points at the horizontal axis and determine
corresponding limits as above.
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17. GemStar Pump Specifications

25 MLHR, 0 mm Hg DELVERY HEAD, START UP

15.0%

g: I 3 Max Posttive Error over 5
DOC 10.0% i 0 Minute Interval = +2.8%
T 50% | /
L|I—J0.0%* \\\\\\\\\\\q_
z
Y 509 | Max Negative Error over 5
Q R Minute Interval = -0.5%
& 10.0% Average Delivery
Rate Error = +1.6%
-15.0% '
0 5 10 15 20 25 30

Observation Interval (minutes)

. &-Max ——Mn ~-Mean

A trained professional can use the resulting graphs to select a pump with the
appropriate startup and flow characteristics to suit the clinical application.

Note: As an example of how the trumpet curves can be used, consider the maximum
and minimum deviations at the 5 minute average interval. The upper curve provides
the maximum expected delivery rate error over a 5 minute interval, the lower curve
provides the minimum expected delivery rate error over a 5 minute interval. An
example would be Dopamine administered at 5 ugm/kg/min. At 5 minutes, the average
drug delivery error would be within the range of +2.8% and -0.5% of the expected
nominal rate.

X
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17. GemStar Pump Specifications

FLOW RATE
0.1 mL, Omm Hg Delivery Head, Start Up

Rate (mL/hr)

Time (minutes)
— Actual Rate --- Programmed Rate

PERCENT ERROR
0.1 mL, 0 mm Hg Delivery Head, Start Up

. 250.0%
& 200.0% A
> 150.0% -
E 100.0%
2 50.0%
s 0.0% +— : : : 2 ; —2
2 -50.0% | ././'//'/’i
& 100.0% |
E -150.0% -
B 1200.0% |

-250.0%

0 5 10 15 20 25 30
Observation Interval (minutes) Observation Interval (minutes)
—&—Max —®— Min —a— Mean
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17. GemStar Pump Specifications

180

Rate (mL/hr)

0.9
0.8
0.7
0.6
0.5
0.3
0.2
0.1
0.0

FLOW RATE
0.1 mL, 0Omm Hg Delivery Head, Hour 96
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Flow Rate Variability (%)
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PERCENT ERROR
0.1 mL, 0 mm Hg Delivery Head, Hour 96

L
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|
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17. GemStar Pump Specifications

FLOW RATE
1 mL, Omm Hg Delivery Head, Start Up
2.0
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1.6 1
1.4 1
L A A N LA Y S YT O A O SO AN L
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§ 0.6
g 0.4
< 021
2 o0
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0.4
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1 mL, 0 mm Hg Delivery Head, Start Up
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17. GemStar Pump Specifications

FLOW RATE
1 mL, Omm Hg Delivery Head, Hour 96
2,0
1,8 1
1,6 1
1,4 1
1,2 1
—_ 10
g 081
= 06
E o4
2 0,2
5} 0,0
M o2
04
0 10 20 30 40 50
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PERCENT ERROR
1 mL, 0 mm Hg Delivery Head, Hour 96
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2 -200%
]
B 300%
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——Max —8— Min —a— Mean
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17. GemStar Pump Specifications

FLOW RATE
25 mL, Omm Hg Delivery Head, Start Up

Rate (mL/hr)
o
o

Time (minutes)
— Actual Rate --- Programmed Rate

PERCENT ERROR
25 mL, 0 mm Hg Delivery Head, Start Up
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17. GemStar Pump Specifications

FLOW RATE
25 mL, Omm Hg Delivery Head, 96 Hour
50.0
45.0 1
40.0 4
35.0
30.0 4
::‘: 25.0 A
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’é 15.0
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PERCENT ERROR
25 mL, 0 mm Hg Delivery Head, 96 Hour
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17. GemStar Pump Specifications

FLOW RATE
25 mL, -100mm Hg Delivery Head, Start Up
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25 mL, -100 mm Hg Delivery Head, Start Up
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17. GemStar Pump Specifications

FLOW RATE
25 mL, +100mm Hg Delivery Head, Start Up

50.0
45.0 1
40.0 1
35.0 1
30.01
4 P+ MA N A A AN LA AN ISV AAAS
25.0 17wy VANV /A VAN W WA VAR RN
20.0 4
15.01
10.0q
5.0
0.0

Rate (mL/hr)

-10.0

Time (minutes)
— Actual Rate --- Programmed Rate

PERCENT ERROR
25 mL, +100 mm Hg Delivery Head, Start Up

15.0%

10.0%

5.0%

0.0%

-5.0% //

Flow Rate Variability (%)

-10.0%
-15.0%
0 5 10 15 20 25 30
Observation Interval (minutes)
——Max —8— Min —a— Mean
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17. GemStar Pump Specifications

FLOW RATE
25 mL, Omm Hg Delivery Head, -20 in H20 Filling Head, Start Up

50.0
450 |
400 |
350
300
25.0 | ARAPATE AR AN AT A A AN AR AR A AR T
200 1

15.0
100 A
50 1
0.0
5.0 1
-10.0

Rate (mL/hr)

Time (minutes)
— Actual Rate --- Programmed Rate

PERCENT ERROR
25 mL, 0 mm Hg Delivery Head, -20 in H20 Filling Head, Start Up

15.0%
£ 10.0% A
>
= 50% - \\;
=
S . - .
§ 0.0% Y —2 T yw— —
% -5.0% A l/././
-4
é -10.0% -
S

-15.0%

0 5 10 15 20 25 30
Observation Interval (minutes)
—&—Max —#— Min —a— Mean
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Chapter 18
Warranty/Technical Assistance

The GemStar Pump has been carefully manufactured using high-quality components.
It is warranted to be free from defects in material and workmanship for a period of one
year from the date of purchase under normal use and service. The warranty on the
optional battery pack and other accessories is limited to 90 days.

On return to Hospira, the pump will be repaired or replaced within the terms of this
warranty. Material returned to Hospira must be properly packaged and sent freight
prepaid.

This warranty shall not apply if the pump has been repaired by anyone other than
Hospira qualified service personnel; or altered in any way which, in Hospira’s
judgment, affects its stability or reliability; or if the serial number has been altered,
effaced, or removed.

THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR
IMPLIED.
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18. Warranty/Technical Assistance

For customer service within the United States, contact:
1-877-9HOSPIRA (1-877-946-7747)

For technical assistance and product return authorization within the United States,
contact:

1-800-241-4002

For additional technical assistance, including Technical Service Bulletins, technical
training, and product information, visit the Web site at:

www.hospiraparts.com
After authorization, ship prepaid product returns to the following address:

Hospira, Inc.
Technical Support Operations
755 Jarvis Drive
Morgan Hill, CA 95037

'\4 Note: Outside the U.S, contact your local Hospira sales office.

.
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Index

Numerics

1-hour dose limit, 55
4-hour dose limit, 55

A

AC mains
power connector, 4
power indicator, 3
Pump Specifications, 171
regarding handling and maintenance, 13
regarding pump operation, 13
AC Mains Adaptor
connecting to, 20
administration set. See pump set
air sensitivity, 77, 83, 107
regarding air-in-line infusion, 13
specifications, 173
air-in-line, alarm, 11, 13
test of, 149
alarm messages, 128—134
alert messages, 135—137
anti-siphon valve, 12, 30, 31
Auto KVO, 5
in mL/hr Only therapy, 85
in Weight Dosed therapy, 79
Auto Taper Down
in TPN therapy, 50
See also taper down; taper up

auto tapering. See Auto Taper Down; taper
down; taper up

B
backcheck valve, 71, 72, 86, 87
BACK-UP key, 3, 28, 97, 102
base rate, 92, 93, 94
batteries, 115
alarm messages, 128—134
battery compartment, 4
battery pack connector, 4
installing disposable batteries, 19
maintenance, 139
power check, 146
specifications, 171
using the rechargeable battery pack, 21
warnings and cautions, 13—16
baud rate, 172
configuration settings for the Data
Port, 113, 118
switch settings for Seiko printer, 114
bolus, 5, 10, 57
bolus button, 4
bolus delivery, 56-57
bolus dose interruptions, 57
clinician instructions, 122, 123
connecting the bolus cord, 156, 166
history, 98
occlusion information, 174
optional system components, 153
in Pain Management therapy, 53—57
print, 98, 109
in Variable Time therapy, 91, 94
1-hour or 4-hour dose limit, 55
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Index

Cc

call back alarm, 61
carrying cases
using the Abbott carrying cases, 159—164
cassette, 30
cassette pocket, 4
cassette release button, 4
cleaning of, 139—141
error message, 129
inspection of, 145
loading the cassette, 32
releasing the cassette, 33
warnings and cautions, 13
Change History, ii
CHANGE key, 3, 28
Change Menu, 8
clinician instructions, 121-125
adding a second lock level, 123
locking the pump, 122
program and deliver a clinician activated
loading dose, 124
unlocking the pump, 124
configuration settings, data port, 113
connecting the Abbott GemStar AC Mains
Adaptor, 20
connecting the bolus cord, 156
connecting to a computer, 116
See also Data Port
connecting to the Seiko printer, 115
See also Data Port
continuous delivery
in Pain Management therapy, 53—58
in TPN therapy, 47, 50
Continuous therapy, 5, 69-75
changing a Continuous Program, 74
Clinician instructions, 122, 123
features and specifications, 69
piggybacking in Continuous
therapy, 71-74
programmable ranges, 75
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programming of, 69

Programming Worksheet, 75

rate titration, 71
contraindications for use, 11

D

Data Port, connecting to, 112—117
configuration settings, 113
connecting to a computer, 116
connecting to the Seiko printer, 115
connector, 4

disconnecting the pump, 23

distal end, 30, 35, 147

distal occlusion, 6, 106
alarm message, 130
occlusion sensitivity, 173
occlusion sensor setting, 107
test of, 148
troubleshooting, 130

docking station, 154
connecting the bolus cord and printer

cable, 166
connecting the pump, 165
disconnecting the pump, 166

dose limit, 55

drip chamber
priming pump sets with a drip

chamber, 38
priming pump sets with a drip chamber
using the PURGE Key, 40

E

event log, 6
history, display, 100
print, 98

F
flow stop, 30, 33, 34, 36, 38, 40, 42, 45, 174
Full Lock, 104

lock level functions, 105
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A

Index

locking the pump, 122
unlocking the pump, 124

G

GemStar pump components, 4
GemStar pump features, 6
GemStar pump layout, 23

H
Heading 1, 17
HELP key, 3, 9, 28, 47, 54, 61, 69, 78, 84,
91, 101, 125, 127
HELP mode, 9
history, 6, 56, 57, 98, 100, 139
display bolus history, 103
display, clear history, 102
print, bolus history, 98, 109

Intermittent therapy, 5, 6167
changing an Intermittent therapy, 66
changing the start time, 98
delivery interruptions, 64—65
features and specifications, 61
Next Dose function, 111
programmable ranges, 67
programming of, 62—63
Programming Worksheet, 67

K
Keep Vein Open. See KVO; Auto KVO
KVO, 5
in Continuous therapy, 69
in Intermittent therapy, 61, 67
in mL/hr Only therapy, 85
in TPN therapy, 47
in Variable Time therapy, 91
in Weight Dosed therapy, 77, 79
troubleshooting, 138

L
lo

lo
lo

lo

lo

ading dose, 5, 55

clinician activated loading dose, 124

delivery, 57-58

in Pain Management therapy, 53

ading the cassette, 32

ck, 3

adding a second lock level, 123

Full Lock, 104, 105

keypad lock, 6, 98, 104

keypad lock level functions, 105

locking the pump, 122

Luer Lock, 12

Rate Change Lock, 58, 104, 105, 122, 123

unlocking the pump, 124

ckboxes

using the Abbott GemStar
lockboxes, 156—159

cking the pump, 122

adding a second lock level, 123

Luer Lock, 12

m

aintenance, 139-141

cleaning and disinfecting, 139

cleaning the cassette pocket and tubing
channel, 141

cleaning the pump case, 140

recommended cleaning solutions, 140

repair, 141

Menu

Programming, Change, Options, 7

mL/Hr Only therapy

VTBI Titration, 86

mL/hr Only therapy, 5, 83—90

Auto KVO, 85

changing a mL/hr Only program, 89
features and specifications, 83
piggybacking, 86—89
programmable ranges, 90
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Index

programming of, 83, 84
Programming Worksheet, 90
rate titration, 85

N
new container, 6
starting a new container, 29
troubleshooting, 136, 138
New Container Lock
locking the pump, 122
unlocking the pump, 124
next dose, 98, 111

0]
occlusion, 106
changing the occlusion sensor
settings, 107
occlusion information, 174-176
occlusion sensitivity, 173
See also distal occlusion; proximal
occlusion
occlusion sensor
changing the occlusion sensor
settings, 107
See also occlusion; distal occlusion;
proximal occlusion
Operating Modes
Help, Programming, Run, Stop, 9
operation test, 143—151
air-in-line test, 149

cassette pocket and latch inspection, 145

display test, 146

distal occlusion test, 148
equipment required, 143
keypad test, 146

LED test, 147

Operation Test Checklist, 151
power check, 146

printing the results, 149
proximal occlusion test, 148

194

test setup, 144
volume accuracy test, 147

optional system components, 153—166
OPTIONS key, 3

display shift totals, 101, 125

Options Menu, 8, 97117

change Pump Settings, 106
connecting to the data port, 112—117
Histories, 99

Keypad Lock, 104

Next Dose, 111

Operation Test, 103

Print, 109

Review Program, 99

Set Clock, 108

Speed Protocol, 110

tips for using the options menu, 97

other display messages, 138

P

Pain Management therapy, 5, 53—60

1-Hour or 4-Hour Dose Limit, 55
alert messages, 135
bolus delivery, 56

changing a Pain Management therapy, 58

features and specifications, 53
loading dose delivery, 57
programmable ranges, 60
programming of, 54-56
Programming Worksheet, 60

piggybacking, 5, 6

canceling a piggyback delivery, 74, 89
changing a piggyback delivery, 73, 88
in Continuous therapy, 71-74
in mL/hr Only therapy, 86—89

preparing for secondary delivery, 72, 87

programming a secondary delivery, 73,
88
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Index

power indicator, 3
power sources
power check, 146
selecting, 18
powering on the pump, 24
prime, 3, 31
priming, 11
priming extension sets, 45
priming pump sets using pre-filled
vials, 42
priming pump sets with a drip
chamber, 38
priming pump sets with a drip chamber
using the PURGE Key, 40
priming pump sets without a drip
chamber using the PURGE Key, 36
pump sets without a drip chamber, 34
See also prime; purge
Print, 109
programmable ranges
in Continuous therapy, 75
in Intermittent therapy, 67
in mL/hr Only therapy, 90
in Pain Management therapy, 60
in TPN therapy, 51
in Variable Time therapy, 95
in Weight Dosed therapy, 81
Programming Menu, 8
accessing the Programming Menu, 26
Programming Worksheet
Continuous, 75
Intermittent, 67
mL/hr Only, 90
Pain Management, 60
TPN, 51
Variable Time, 95
Weight Dosed, 81
proximal end, 30, 147
proximal occlusion
alarm messages, 133
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occlusion sensitivity, 173
test of, 148
pump components, 4
pump features, 6
pump layout, 2-3
pump set, 12—16, 29, 167-169
GemStar Piggyback Pump Set, 69
pump components, 4
See also pump settings
pump settings, 3, 98
air sensitivity, 107
change pump settings, 106
occlusion sensor, 107
sound level, 108
pump specifications, 171-173
PURGE key, 3
priming pump sets with a drip chamber
using the PURGE Key, 40
priming pump sets without a drip
chamber using the PURGE Key, 36

R
Rate Change Lock, 58, 104, 122, 123
lock level functions, 105
locking the pump, 122
unlocking the pump, 124
rate titration
in Continuous therapy, 71
in mL/hr Only therapy, 85
in Weight Dosed therapy, 79
releasing the cassette, 33
RUN mode, 9

S
SILENCE key, 3
Speed Protocols, 6, 98, 109
assign, review/recall, delete, 110—111
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Index
START key, 3 U
starting a new container, 29 unlocking the pump, 124
STOP key, 3 UP/DOWN key, 28
STOP mode, 9
v
T Variable Time therapy, 5, 91-96
taper down, 47, 48, 50 changing a Variable Time program, 94
taper up, 47 delivery interruptions, 93

technical assistance, 190
Therapies, 5
Continuous, 6975
Intermittent, 61-67
mL/hr Only, 83-90
Pain Management, 53—60
Total Parenteral Nutrition (TPN), 47-51
Variable Time, 91-96
Weight Dosed, 77
Therapy Lock, 104
lock level functions, 105
Locking Sequence Instructions, 122
unlocking the pump, 124
Titrate Rates, 5
Titrate VIBI, 5
Total Parenteral Nutrition. See TPN
therapy
TPN therapy, 5, 47-51
Auto Taper Down, 50
changing a TPN program, 49
features and specifications, 47
programmable ranges, 51
programming of, 48
Programming Worksheet, 51
troubleshooting, 127—138
alarm messages, 128—134
alert messages, 135
other display messages, 138
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features and specifications, 91

programmable ranges, 95

programming of, 91

Programming Worksheet, 95
Volume To Be Infused. See VTBI
VTBI, 70, 78, 84

piggyback VTBI, 71-73, 86—88
VTBI Titration, 80, 86

w

warnings and cautions, 11

Weight Dosed therapy, 5, 77
Auto KVO, 79
changing a Weight Dosed program, 80
features and specifications, 77
programmable ranges, 81
programming of, 78
programming worksheet, 81
rate titration, 79
VTBI Titration, 80

Y
YES/ENTER key, 3, 28, 47, 54, 61, 69, 78,
84, 91
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CAUTION: Federal (USA) law restricts this device to sale by or on the order of
a physician or other licensed practitioner.

DANGER: Possible explosion hazard exists if used in the presence of
flammable anesthetics.

Authorized Representative:
Hospira

0050 Finisklin Business Park
Sligo, Republic of Ireland

The ‘C’ and ‘US’ indicators adjacent to the CSA Mark signify that the
product has been evaluated to the applicable CSA and ANSI/UL Standards,
S P ® MCN 160992 for use in Canada and the U.S., respectively. This ‘US’ indicator includes
products eligible to bear the ‘NRTL’ indicator. NRTL, i.e. National
c us Recognized Testing Laboratory, is a designation granted by the U.S.
Occupational Safety and Health Administration (OSHA) to laboratories
which have been recognized to perform certification to U.S. Standards.

[ ]
Equipment providing a degree of protection higher than that for Type B
equipment against electrical shock particularly regarding allowable leakage
currents and having an F-Type applied part.

Type BF

IPX 1 Protected against dripping water.

Attention: Consult accompanying documents.

GemStar, LifeShield, HEMA, and CAIR are registered trademarks of Hospira, Inc. Luer Lock is trademark of Hospira,
Inc., Super Edisonite, Seiko, Vesphene II se, Manu-Klenz, Formula C, Teflon, Velcro, CLAVE, and Microsoft,
Windows, and Windows NT are not trademarks of Hospira.

This document and the subject matter disclosed herein are proprietary information. Hospira retains all the exclusive
rights of dissemination, reproduction, manufacture and sale. Any party using this documentation accepts it in
confidence, and agrees not to duplicate it, in whole or in part, nor disclose it to others without the written consent of
Hospira.

© 2005 Hospira, Inc.
Lake Forest, Illinois 60045, USA
Printed in USA
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